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Getting Started 1.1

Chapter Overview

This chapter introduces and describes the basic steps involved

in using NCSA Telnet for the Macintosh:

• invoking the program

• opening and closing a telnet connection

• copying, pasting, and printing the contents of session

windows

• exiting the program

The chapter assumes that your system or network

administrator has installed NCSA Telnet on your system,

assigned an IP address to your Macintosh, and given you a

login name and password for the computer to which you want

to connect. For information regarding installation and

customization procedures, refer to Chapter 8, "System

Administration Information."

In addition, the chapter assumes that you know how to click

and drag using the mouse, move and resize windows, and

select items from menus. If you are unfamiliar with the

Macintosh user interface or need additional information

regarding these procedures, please refer to your Macintosh

user's guide.

Beginning a Telnet Session

Invoke NCSA Telnet by double-clicking on the NCSA Telnet file

or application icon. The NCSA Telnet application icon is shown

in Figure 1.1.

A startup dialog box appears to introduce NCSA Telnet, then

disappears.

Figure 1.1 Telnet Program

Icon

To open a connection to a telnet host:Opening a
Connection

1. Select Open Connectionfrom the File menu, shown in

Figure 1.2. A connection dialog box, shown in Figure 1.3,

appears.

2. Enter as the session name the name of the telnet host

to which you want to connect. The session name can be any

host name, IP address, or an Alias.

3. Enter any name for the session window as the window

name. This is an optional feature that is not necessary with

single connections, but very useful when you have multiple

connections.

4. Click OK or press RETURN.

5. If you want to connect as an FTP client, select FTP

Session by clicking the appropriate box. For information
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regarding the FTP client, please see Chapter 5, "File

Transfer."

6. If you want to start either a serial or SLIP session,

cleck the appropriate box. For information regarding SLIP

and serial communications, please see Chapter 9, "Serial

Communications."

NCSA Telnet attempts to connect to the host you specified, a

process that generally takes only a few seconds. When a

connection has been established, a session window appears.

The name you specified for the window appears in the title

bar of the session window, and under the Connections menu.

Figure 1.2 File

Menu

Figure 1.3

Connecti

on Dialog Box

For information regarding alternative ways to open a

connection, session names other than the hostname, and

working with multiple sessions, see Chapter 4, "Advanced

Features." A discussion of the purpose and function of the

Configure button is contained in Chapter 3, "Customizing the

Environment."
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Logging in to Your
Host

The session window indicates the name and type of your host

machine and prompts you to enter your login name. For

example, if you attempt to connect to a Sun system dubbed

pluto, the login prompt may look like this:

SunOS UNIX (pluto)

login:

To log in:

1. Enter your login name at the login prompt and press

RETURN. The host prompts you to enter your password.

2. Enter your password and press RETURN.

From this point on, NCSA Telnet operates as a VT102

terminal remotely connected to the host.

NOTE:  The response time of the host may vary. If the remote

host is heavily loaded it may take a few minutes after the

connection has been opened for the host to prompt you to log

in.

NCSA Telnet emulates a VT102 terminal. When you log on to a

host, the host operating system does not always know what

type of terminal you are using. For instructions on setting the

terminal type, consult the operating system manual for the

host you will be using.

Setting a Terminal
Type

Try setting the terminal type to VT100 or VT102. For

systems that do not support VT102 (such as many UNIX

systems), use VT100 or tab132 (compatible with VT102

emulators).  Telnet 2.5 can also let you set the terminal type

to VT200.

The following examples show how to set the terminal type for

two popular operating systems and hosts—UNIX (using the C

shell) and VAX/VMS.

UNIX (C–Shell)

pluto% set term=vt100;tset           (for vt100)
pluto% set term=vt200;tset           (for vt200)

VAX/VMS

B$ set term /inq

To close a connection to your host, use the logout procedure

specific to that system. For example, you would enter the

UNIX logout command (logout) at the command line prompt:

Closing a
Connection

pluto%  logout
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If you are unable to log out in this manner, select Close

Connection from the File menu. A dialog box appears to

confirm that you want to forcibly close the connection. Click

OK or press RETURN. A sample message the Close Connection

dialog box might display is shown in Figure 1.4.

Figure 1.4 Sample Close

Connection Dialog Box

After you have logged out, the session window disappears. You

can now safely quit the NCSA Telnet application.

Cutting, Copying, Pasting, and Printing

NCSA Telnet allows you to cut, copy, paste, and print the

contents of your session windows. To cut, copy, paste, or

print, first select a region of text from the window.

To cut a selected region from a window, select Cut from the

Edit menu. The selection is removed from the window and

placed on the Clipboard.

To copy a selected region of a window "as is," select Copy from

the Edit menu.

To copy a selected region of a window as a table, choose Copy

Table from the Edit menu. White spaces in the selected region

are replaced by tabs according to the setting of the Copy Table

Threshold in the Preferences dialog box, so that you can paste

the table into a word processing or spreadsheet program such

as Microsoft Excel.

To paste the contents of the Clipboard into a session window,

select Paste from the Edit menu.

To print a selected region:

1. Choose Page Setup from the File menu, specify the

desired printing parameters in the dialog box that appears,

and click OK or press RETURN.

2. Choose Print Selection from the File menu. Specify the

number of copies, printer feed, and other parameters in

the Print dialog box appears, and click OK or press

RETURN.
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For more information regarding the Page Setup or Print

dialog boxes, refer to your Macintosh user's guide.

NOTE:  Copying and Pasting are also discussed in Chapter 6,

"Tektronix 4014 and 4105 Emulation," and Chapter 7,

"Interactive Color Raster Graphics." The Copy Table

Threshold is discussed in the section entitled "Using the

Preferences Dialog Box" in

Chapter 3.

Exiting NCSA Telnet

To exit NCSA Telnet, select Quit from the File menu.

NOTE:  Telnet allows you to quit the application at any time

during the program's execution; however, to avoid loss of data

or other complications, you should close connections to each

system before quitting NCSA Telnet, whenever possible. If you

do attempt to quit the application before closing the current

connections, a dialog box appears to confirm that you want to

forcibly close the connections. If you do, click OK or press

RETURN; otherwise, click Cancel.
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Using the Keyboard 2.1

Chapter Overview

This chapter discusses the special keyboard features of NCSA

Telnet. It explains, for example, how to use command key

equivalents of menu commands; set the functions of the

BACKSPACE (or DELETE), OPTION, and Backquote keys; use the

Macintosh keyboard to emulate a VT102 keyboard; and define

your own macros. It also supplies some information about

emulation a VT200 terminal, which is a new feature in this

version of Telnet.

Using Keyboard Commands

NCSA Telnet understands both menu and key commands. Some key

commands are optional equivalents of menu commands; others are

equivalent to key commands on a VT102 terminal. The following

sections discuss keyboard options and list the keyboard commands

understood by NCSA Telnet.

If you want to be able to use command key equivalents for menu

commands:

Emulating Menu
Commands

1. Select Preferences from the Edit menu. The Preferences

dialog box appears (Figure 2.1).

2. Check the box labeled Command keys by clicking on it.

When the Command keys option is checked, the command keys

appear in the menus next to their corresponding menu

commands.

3. Click OK or press RETURN to activate the command keys

option for the current telnet session only. Click Save if you

want the option to be activated every time you invoke NCSA

Telnet.

For more detailed information about the Preferences dialog box

and the options it contains, refer to the section,"Using the

Preferences Dialog Box," in Chapter 3.
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Figure 2.1 Preferences

Dialog Box

NCSA Telnet lets you change the functions of the BACKSPACE (or

DELETE), OPTION, and Backquote keys to accommodate your needs

or preferences—a feature you may find especially useful if you

are using a Macintosh Plus keyboard.

Setting the Functions
of BACKSPACE (or
DELETE), OPTION, and
Backquote

BACKSPACE (or DELETE)

NCSA Telnet automatically translates BACKSPACE keypresses into

delete codes, for compatibility with systems that prefer delete to

backspace. If you find that your backspaces are not being

accepted, the host you are using may only accept backspace codes.

To test this possibility, change the setting of the BACKSPACE (or

DELETE) key to backspace according to the instructions below.

This action resets the default translation, so that the key sends a

backspace code. If your backspaces are accepted, then the host

prefers backspace codes.

There are four ways to set the function of the BACKSPACE (or

DELETE) key to backspace when you open a connection.

• the Configuration dialog box

• the Backspace and Delete options in the Session menu

• a saved set that includes your preferred setting

• the keyword erase in your configuration file

To use the Configuration dialog box:

1. Click the Configure button in the Connection dialog box

that appears when you first open a connection. The

Configuration dialog box appears (Figure 2.2).
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2. Click the radio button labeled Backspace in the row

Backspace Is.

3. Click OK or press RETURN.

For information regarding the other options contained in the

Configuration dialog box, refer to "Using the Configuration Dialog

Box" in Chapter 3.

Figure 2.2 Configuration

Dialog Box

You can also set the function of the BACKSPACE (or DELETE) key

by enabling the Backspace or Delete option in the Session menu. A

checkmark appears in the menu beside the active function (see

Figure 2.3). In this manner, you can change the function of the

BACKSPACE (or DELETE) key during a telnet session.
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Figure 2.3 Session

Menu

If you use this host frequently, you may want to save your

BACKSPACE (or DELETE) setting according to the instructions

presented in the section entitled "Saving Session Characteristics"

in Chapter 4. Then, whenever you load the saved set, the function

of the BACKSPACE (or DELETE) key is automatically set to your

preference. Alternatively, your system administrator can

"permanently" reset the Backspace function for this session or

for all sessions, using the configuration file as instructed in

Chapter 8, "System Administrator Information."

OPTION

In some instances, you may need to be able to use the OPTION key

as a substitute for the CONTROL key—for example, if you are

using a Macintosh Plus, whose keyboard has no CONTROL key.

NOTE:  This option is not permitted under System 7.0.

To set the OPTION key as a substitute for the CONTROL key, and

are not using System 7.0:

1. Select Preferences from the Edit menu.

2. Check Remap option key to control.
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3. Click OK or press RETURN if you want the setting to apply

to this telnet session only. Click Save to make this the default

setting for the OPTION key.

NOTE:  If you are working on a Macintosh Plus and want to use

the Command keys option, you should also check the Remap option

key to control option; otherwise, you will not be able to generate

control characters.

If you have a CONTROL key on your keyboard, it is not

recommended that you use the Remap option key to control option

because it changes the standard Macintosh key assignments.

NOTE:  When the Command keys option is disabled, the �  key

may also be used as the CONTROL key.

Backquote

If you want to substitute the Backquote key (Figure 2.4) for ESC;

that is, if you want the Backquote key to send the ASCII character

ESC:

1. Select Preferences from the Edit menu.

2. Check Remap backquote to ESCape.

3. Click OK or press RETURN if you want the setting to apply

to this telnet session only. Click Save to make this the default

setting for the Backquote key.

~
`
~

Figure 2.4 Backquote

Key

NOTE:  When you check the Remap backquote to ESCape option,

the only way you can send the ASCII character backquote (`) is to

press � -Backquote or OPTION-Backquote. The capability of

SHIFT-Backquote to send a tilde is unaffected by the setting of

this option.

When NCSA Telnet is running, the Macintosh appears to the host

as a VT102 terminal. NCSA Telnet transmits keystrokes for keys

common to the Macintosh and VT102 keyboards without

modifying them; however, the VT102 keyboard has some keys

that the Macintosh keyboard does not have, and treats or labels

other keys differently. In addition, many VT102 keys have

special meanings when they are transferred to the host.

Emulating a VT102
Terminal

You can use the Macintosh keyboard to provide full VT102

functionality. Table 2.1 lists the Macintosh keys commands that

correspond to key commands on a VT102 terminal. Note that the

numeric keypad on the Macintosh is identical in position to that
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of the VT102, although the labels differ. If you are accustomed to

typing on a VT102 keypad, you can ignore the Macintosh labels

and type as usual.

Table 2.1 Macintosh Keys Used for VT102 Terminal Emulation

Equivalent Keystroke on Equivalent Keystroke on
VT102 Key Macintosh Plus Keyboard Apple Desktop Bus Keyboard

Backquote � -Backquote or � -Backquote or

OPTION-Backquote † OPTION-Backquote †

ESC†† Backquote ESC or Backquote

DELETE††† BACKSPACE DELETE or DEL

BACKSPACE††† � -BACKSPACE or † � -DELETE or †

OPTION-BACKSPACE OPTION-DELETE

LINE FEED CONTROL-J CONTROL-J

PF1 Clear on keypad Clear on keypad (or F1)

PF2 \ on keypad \ on keypad (or F2)

PF3 = on keypad = on keypad (or F3)

PF4 * on keypad * on keypad (or F4)

CONTROL-SPACE(NUL) OPTION-SPACE CONTROL-SPACE or

OPTION-SPACE

Keypad keys Keypad keys Keypad keys

† Use of �  or OPTION depends on setting of Command keys option in the Preferences dialog box.

†† Use of Backquote as ESC is governed by the setting of the Remap backquote to ESCape option in

the Preferences dialog box.

††† See the discussion of backspace and delete in the section entitled " Setting the Functions of

BACKSPACE (or DELETE), OPTION, and Backquote."

Telnet 2.5 has the new feature of being able to emulate a VT200

terminal. That gives Telnet the ability to send VT200 esacpe

codes with the Mac keyboard. For an overview of these escape

codes, please see Appendix E, "VT200 Escape Codes."

Emulating a VT200
Terminal

NCSA Telnet uses certain key combinations for the telnet

functions Interrupt, Suspend, and Resume functions, which are

discussed in the following sections.

Changing the Assigned
Keys for Interrupt,
Suspend, and Resume

To change any of the key combinations assigned to these functions:
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1. Select Setup Keys from the Session menu, as shown in

Figure 2.5. The Setup Keys dialog box appears (see Figure

2.6).

2. Change the key assignments for the functions to any other

control characters by typing the character(s) in the

appropriate box, or disable a function altogether by deleting

the entry in its respective box.

3. Click OK or press RETURN.

You may also set the key assignments to Interrupt, Suspend, and

Resume in the configuration file (see Chapter 8).

Figure 2.5 Session

Menu
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Figure 2.6 Setup Keys

Dialog Box

The initial key assignments for Interrupt, Suspend, and Resume

and their functions correspond to the traditional interpretation

of the ASCII character, as described in the following sections.

Interrupt (CONTROL-C)

Interrupt sends a telnet interrupt process character, equivalent

to the Interrupt Process command in the Network menu (see

"Network-Related Commands" in Chapter 4). The host

implementation of telnet is required to listen for and interrupt

the current application when this option is received.

Interrupt also does a timing mark operation. In many

implementations of telnet, you press CONTROL-C and often wait

several minutes before the text stops scrolling on your screen.

This occurs because the TCP protocol has buffered up to 16K or

even 32K bytes of data, which is waiting in the pipeline to be

delivered even before you press CONTROL-C. To remedy this

situation, NCSA Telnet initiates a process known as timing mark

flush when you issue an interrupt command.

To do timing mark processing, NCSA Telnet sends a special

character to the host which the host echoes back. While waiting

for the host to echo, all characters for that session are thrown

away. It appears that the session pauses for up to 15 seconds and

then resumes as usual. During the pause, NCSA Telnet is

throwing away all of the buffered data so that you do not have to

wait for it to be displayed.

Suspend(CONTROL-S)

Suspend instantly interrupts all output coming from the

network. The current session will not produce any more

characters on the screen until you issue the Resume command.
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Resume (CONTROL-Q)

Resume allows character printing to resume to the current

session. Resume does nothing unless a Suspend command is in

effect.

Defining Macros

NCSA Telnet allows you to use the key combinations � -0 through

� -9 as macro keys. You can program these keys to send from 0

to 255 characters.

To define a macro:

1. Select Set Macros from the Edit menu or press � -M. The

Macro Configuration dialog box that appears is shown in

Figure 2.7 with several sample macro definitions.

2. Click the button of the command key you wish to define, or

select the box next to that button.

3. Enter the appropriate macro key sequence as instructed

in the following section.

4. Click OK to activate the new macros, or click Cancel to

invalidate the additions or changes you made. When you click

OK or Cancel, you are returned to the application.

Figure 2.7 Macro

Configuration Dialog

Box

NOTE:  Your macros are saved when you save your set as

instructed in the section entitled "Saving Session

Characteristics" in Chapter 4.
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Reverting to the
Previous Macro
Definitions

While you are working in the macro configuration dialog box, you

can undo changes you made to a macro and revert the associated

command key to its previous setting by clicking the button that

corresponds to that command key. For example, if you want to

undo changes to the definition for � -2, click the button labeled

� 2. If you want to simultaneously abandon all of the changes that

you have made, click Cancel.

Entering Macro Key
Sequences

The key sequences used to generate special control characters in a

macro may seem somewhat strange, unless you are familiar with

the C programming language. To define a special character, you

must first enter a backslash (\). Indicate non-typable control

characters with octal numbers. Table 2.2 shows some special

characters you might enter.

Table 2.2 Common

Macro Key

Combinations

Desired Character Definition
Backslash (\) \\

TAB \t

ESC \033

CONTROL-C \003

CONTROL-D \004

CONTROL-E \005

CONTROL-H or BACKSPACE \010

Size of current window† \#

Internet number of this Macintosh†† \i

† pertains to setting the number of usable lines in a session window

(see the section entitled "Using the Session Menu" in Chapter 3).

†† see also the discussion of the Show Network Numbers command

contained in "Network-Related Commands" in Chapter 4, and of the

Send IP Number command contained in "Transferring Files" in

Chapter 5.
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Chapter Overview

NCSA Telnet allows you to customize the environment to suit your

special needs and habits. This chapter covers some more advanced

aspects of the NCSA Telnet working environment. It describes

how to change the configuration settings, set the characteristics

of session windows, and customize other NCSA Telnet operations

using the Preferences dialog box and the Session menu.

Using the Configuration Dialog Box

NCSA Telnet allows you to specify certain configuration

characteristics from within the application, right before you

open a particular connection. For example, you can change the

window name for a connection, set the function of the BACKSPACE

(or DELETE) key, and specify whether Tektronix graphic images

are displayed in separate windows.

To configure a telnet session:

1. Choose Open Connection from the File menu or press � -

O. The Connection dialog box shown in Figure 3.1 appears.

2. Specify a session name.

3. Click Configure. The Configuration dialog box appears

(Figure 3.2).

Figure 3.1 Connection

Dialog Box
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Figure 3.2 Configuration

Dialog Box

Window Name The session name serves as the window name and appears in the

session window's title bar, unless you designate a different

window name. To designate a window name, enter the desired

name in the Window Name box. (You may also specify the window

name by entering the name in the Window Name box of the

Connection dialog box.)

A session window may contain either 80 or 132 columns. Specify

the number of columns to be displayed in your session window by

clicking the appropriate radio button in the row labeled Columns.

Columns

For information regarding changing the number of lines

displayed in a session window, see the section of this chapter

entitled "Set Usable Lines."

NOTE:  When you specify 132 columns, you may not be able to

see all of the columns in a session window at one time. You can

resize the session window and use the horizontal scrollbar to

view obstructed columns.
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Backspace Is The BACKSPACE (or DELETE) key may be used to send backspace

or delete codes. To assign the function you prefer to this key,

select either Backspace or Delete in the row labeled Backspace Is.

For more information regarding the BACKSPACE (or DELETE)

key, see "Setting the Functions of BACKSPACE (or DELETE),

OPTION, and Backquote" in Chapter 2.

Tek Clear Screen The default setting for this option is Clears Screen. The Tek Clear

Screen setting applies while you are operating in the Tektronix

drawing mode. By default, when a clear screen code is received

and you generate a new image, the screen is cleared; that is, any

drawing on the screen is overwritten with a new image.

If you change the default by selecting the Creates Window option,

and then generate a new image, a new window is created for the

image and the contents of the active screen are not overwritten.

Each new screen created in this way has as its name the session

name and time. For more information regarding Tektronix

drawing mode and the clear screen code, refer to Chapter 6,

"Tektronix 4014 and 4105 Emulation."

This option allows you to change the type of end-of-line marker

sent by the Macintosh and establish compatibility with some 4.3

BSD UNIX systems. The default for this option is CRLF. When

CRLF is active, NCSA Telnet sends a carriage return followed by a

line feed. Select CR-NUL to instruct NCSA Telnet to send a

carriage return followed by NUL, if that is needed by your host.

Return Sends

You can set NCSA Telnet to operate in either of two echo modes:

local or remote. In local echo mode, characters are copied to the

screen immediately as you type them. In remote echo mode, the

characters are sent to the host, which sends them back to be

printed. The Echo Mode option only applies when you are

operating in local echo mode.

Echo Mode

To enter local echo mode, also known as line mode, enable the

Local Echo option in the Session menu. The menu item appears

checked when local echo mode is active.

You can use the Echo Mode option in the Configuration dialog box

to configure Local echo mode to work in either of two ways:  the

characters you type can be buffered locally and sent when you

press RETURN, or they can be sent immediately as you type. To

specify the former, select the Buffers option in the Configuration

dialog box. To specify that each character be sent immediately as

you type it—a process known as half duplex—select Sends.
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NOTE:  Keystrokes that include control characters, including tab

and return, are always sent immediately as they are typed.  Some

hosts force local echo mode automatically. If local echo mode is

not forced by your host, you may still want to enable it to

improve keyboard response time. Local echo mode should be used

carefully, because it is incompatible with most full-screen

editors.

TEK Mode You can specify the default TEK emulation type, either 4014 ,

4105, or none. with this control. If you select "none," then

Telnet will not allow TEK displays on screen. Your system

administrator can also set the initial value within the

configuration file.To do this, see chapter 8, "System

Administrator Information." After you open a session, The

specified TEK Mode becomes the default.

Check the box labeled Scrollback to activate the scrollback

feature.

Scrollback

To change the number of lines that NCSA Telnet saves and allows

you to view by scrolling, type the desired integer in the text box.

The default is usually 200 lines, although this may have been

changed by your system administrator in the configuration file.

If you reset the number of scrollback lines and then save this

configuration using Save Set, the setting is saved as part of that

set (see "Saving Session Characteristics" in Chapter 4).

NOTE:  The scrollback feature gradually consumes memory for

the number of scrollback lines that you specify, so be sure to

watch your memory consumption if you specify a high number of

scrollback lines.

NCSA Telnet supports the Telnet Linemode Option, developed by

the Internet Engineering Task Force-Telnet Linemode Working

Group, and which is being implemented by Cray. In previous

versions of NCSA Telnet, the program would send out data one

character at a time, which resulted in a large amount of network

overhead for large multi-user systems.

Linemode

Now when you enable the linemode option, NCSA Telnet sends data

to the host machine a line at a time rather than a character at a

time, thus greatly reducing network traffic.

NOTE:  Even if linemode is set for enable, NCSA Telnet can only

use linemode if the host machine supports it.  Therefore, the use

National Center for Supercomputing Applications



Customizing the Environment 3.5

of the linemode feature is ultimately decided by the connected

host's capabilities.

Eight Bit Font
Telnet now has the ability to pass through characters with the

high-bit set. If you choose the Eightbit option, visible characters

with the high bit set will be handled properly. If not, Telnet

strips the high bit off of such charaters, as it did in all previous

versions.

Using the Preferences Dialog Box
The options contained in the Preferences dialog box are described

in the following sections.

To use the Preferences dialog box:

1. Select Preferences from the Edit menu. The Preferences

dialog box that appears contains a check box for each option

available. The Preferences dialog box is shown in Figure 3.3.

2. Specify a Copy Table Threshold by clicking within its box

and entering the desired number by typing on your keyboard.

3. Select or deselect an option by clicking the box that

appears before it. The box becomes checked or unchecked to

indicate that the option is activated or deactivated,

respectively.

4. Click OK or press RETURN to apply the selected options.

Click Save to save the specifications as the default, so that next

time you invoke NCSA Telnet, these options are activated

automatically. Click Cancel to undo any changes you have made.

When you click one of these buttons or press RETURN, you are

returned to the application.
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Figure 3.3 Preferences

Dialog Box

Copy Table Threshold The Copy Table Threshold value determines the number of spaces

which, at a minimum, are replaced by tabs when you issue the

Copy Table command from the Edit menu or press � -T. Instead of

using the standard Copy command, you can use the Copy Table

command to copy tables of data from the NCSA Telnet screen onto

the Clipboard.

When you use the Copy Table command, all strings of contiguous

spaces that are greater than the threshold are turned into tabs

before being placed on the Clipboard. This produces a format that

can be pasted into most spreadsheets and graphing programs

without losing data or requiring additional formatting.

By checking the Command keys option in the Preferences dialog

box, you obtain access to command key equivalents for commands

listed in the individual menus. This option also determines

whether the � -key functions as the CONTROL key. When the

Command keys option is checked, the command key equivalents

are listed beside their corresponding items in the menus and �

does not translate to CONTROL. For more information regarding

command keys, see "Using Keyboard Commands" in Chapter 2.

Command Keys
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Remap Option Key to
Control

Select Remap option key to control if you want the OPTION key to

substitute for the CONTROL key. This option is most useful on

machines such as the Macintosh Plus, which has no control key of

its own.  However, it is not available under Operating System 7.

NOTE:  If you are working on a Macintosh Plus and want to use

the Command keys option, you should only do so in conjunction

with the Remap option key to control option; otherwise, you will

not be able to generate control characters.

For more information regarding changing the function of the

OPTION key, see "Setting the Functions of BACKSPACE (or

DELETE), OPTION, and Backquote" in Chapter 2.

Select Remap backquote to ESCape when you want to use the

Backquote key as the ESC key. When this option is checked,

pressing the Backquote key, sends an ASCII ESC character. For

more information regarding this option, refer to "Setting the

Functions of BACKSPACE (or DELETE), OPTION, and Backquote"

in Chapter 2.

Remap Backquote to
ESCape

MacBinary The MacBinary option controls the default setting for the

MacBinary Enabled option in the File menu. When this option is

checked, the MacBinary Enabled option (and consequently

MacBinary mode) are activated by default when the application is

started. See Chapter 5, "File Transfer," for more information on

MacBinary mode.

The Reset MacBinary for each FTP option controls whether the

MacBinary mode setting is to be returned to its default state upon

the initiation of an FTP session. The default state of MacBinary is

whatever you last set for the MacBinary option (see the

preceding section,"MacBinary").

Reset MacBinary for
Each FTP

NOTE:  "Each FTP" corresponds to establishing the FTP command

connection and not the individual file transfer.

Select Windows don't go away on close if you want the session

window to be displayed on the screen even when its associated

connection has been terminated.

Windows Don't Go Away
on Close

This feature allows you to read, copy, and print text that is in a

window whose connection has been closed. To close such a window,

click in its close box.
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Staggered Windows When you've selected the Staggered Windows option, the program

staggers multiple windows by a whole title bar, allowing you to

see each window's title. Otherwise, NCSA Telnet only staggers the

windows by a few pixels.

Telnet 2.5 has the ability to map characters from the System

KCHR resource instead of KCHR built into Telnet. This allows

users to have all the keys mapped by the system, instead of each

particular application. If this feature is desired, select this

option.

System KCHR

Click the "Blink Cursor" button if you want the cursor to blink

during a Telnet session.

Blink Cursor

You can now select what kind of cursor Telnet uses for text

display. Click the appropriate button to choose either a block

cursor, underscore cursor, or vertical bar cursor. See figure

3.4 for an example of each cursor type.

Cursor Selection

Figure 3.4 Cursor Typos

Using the Session Menu

The items in the session menu, depicted in Figure 3.5, are

described in the following sections.  For more information,

however, you may want to refer to chapter 4, "Advanced

Features."
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Figure 3.5 Session

Menu

Backspace Enable the Backspace option to set the function for the

BACKSPACE (or DELETE) key to backspace. When you enable the

Backspace option, the option appears checked in the menu. For

more information, see "Setting the Functions of BACKSPACE (or

DELETE), OPTION, and Backquote" in Chapter 2.

Enable the Delete option to set the function for the BACKSPACE

(or DELETE) key to delete. When you enable the Delete option,

the option appears checked in the menu. For more information,

see "Setting the Functions of BACKSPACE (or DELETE), OPTION,

and Backquote" in Chapter 2.

Delete

Local Echo Enable the Local Echo option to enter local echo mode, which is

described in this chapter's section,"Echo Mode." When you enable

the Local echo mode, the option appears checked in the menu.

Enable the Wrap Mode option to activate wrap mode. In NCSA

Telnet, wrap mode controls the status of the wrap setting. When

you enable the Wrap Mode option, it appears checked in the menu.

Wrap Mode
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The VT102 terminal maintains an internal setting to determine

whether characters printed off the right hand side of the screen

cause the terminal to wrap or not. If you set the terminal to

wrap, the new characters appear on the next line of the screen

and the screen is scrolled if necessary. If you disable wrap mode,

each new character replaces the last character on the current

line and the cursor neither moves right nor onto the next line.

You may also set the wrap mode in the configuration file (see

Chapter 8 for details). Whenever you select the Reset Terminal

command in the Session menu, wrap mode is disabled.

NOTE:  Host software commonly sets the wrap mode, overriding

this setting.

This option toggles between saving lines and erasing lines when

the clear screen code is received. If you check the option, all

lines currently displayed on the screen are scrolled into the

scrollback region before the screen is cleared. If you do not check

it, the cleared lines are permanently disposed when the screen is

cleared.

Clear Screen Saves
Lines

Select Reset Terminal to reset the VT102 screen, for example,

when a host program accidentally sets graphics mode or fails to

leave graphics mode. The Reset Terminal command resets all

VT102 mode settings—disabling wrap mode, resetting graphics

mode, resetting the keypad mode to the default, and resetting tabs

to every eight spaces.

Reset Terminal

Select Jump Scroll to skip to the end of the local buffer.Jump Scroll

The Jump Scroll option causes the screen to pause and then jump

ahead over scrolling text. The text is placed into scrollback, but

the screen update advances to the end of the local network buffer

instead of printing every line on the screen.

The purpose of this feature is to save time. For example, when

you enter a command that produces a great deal of output, you can

use Jump Scroll to avoid waiting for the output to scroll by.

Select TEK Page to quickly create or clear a Tektronix emulation

window without requiring intervention from host software.

TEK Page

Normally the emulation window appears automatically when the

clear screen command sequence is received from the host. But the

TEK Page command creates the window immediately. To clear the
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current session window, use the TEK Page command the same way

you would use the Page key on a real Tektronix terminal. For

more information regarding the clear screen command and

Tektronix emulation, refer to Chapter 4, "Advanced Features."

TEK Form Feed Clears
Screen

Another new feature in Telnet 2.5 is the ability to supress Telnet

from clearing the screen during TEK emulation. Often TEK images

include a form-feed command at the end of them, and that causes

the TEK screen to be immediately cleared upon reaching the end

of the image. However, this makes it hard to see the final image of

the TEK file.

Therefore you can now set this option to false, in which case

Telnet will not clear the TEK window when it encounters a form-

feed command. If this option is set to true, then Telnet acts just

as it normally would.

Select this option to increase or decrease the number of lines

displayed per screen in a session window.

Set Usable Lines

NCSA Telnet session windows initially display 24 lines per

screen by default, because the actual VT102 terminal screen has

room for exactly 24 lines of text. Some host systems, allow you

to define a VT102-like terminal type which has more or fewer

than 24 lines.

To increase or decrease the number of lines displayed per screen

in a session window:

1. Select Set Usable Lines from the Session menu. The Set

Lines dialog box appears, showing the current number of lines

displayed (Figure 3.6).

2. Enter a value from 10 to 200 to specify the desired

number of lines.

3. Click OK or press RETURN to return to your session

window or click Cancel to abort the change.

After you change the number of lines for a screen, the size of the

window changes to accommodate the new number of lines.
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Figure 3.6 Set Lines

Dialog Box

Shortcut

To quickly change the number of lines displayed per screen in a

session window, hold down OPTION while adjusting the size of the

window using the size box. As the window changes size, NCSA

Telnet recalculates the number of lines in the window. When you

release the mouse button, the number of usable lines in the

window exactly fills the window. This method is equivalent to

using the Set Usable Lines command.

WARNING:  If you do not have a good working knowledge of how

your host system makes us of terminals with greater than 24

lines, you are recommended to use only 24-line windows. The

following warnings and suggestions assume knowledge of UNIX-

based software to control the number of lines for the terminal.

Consult your host system documentation or system administrator

for more information.

Warnings and Suggestions

The termcap file, (found in UNIX systems only), is commonly

located in /etc/termcap, and can be set up to include the number

of lines on the terminal. The default VT100 termcap includes an

explicit setting of 24 lines, so even if you enlarge your NCSA

Telnet window, the host uses only the top 24 lines. You can create

special termcap entries by editing the /etc/termcap file. Copy

the VT100 entry to a new name and change the number of lines to

your preferred screen size.

Berkeley UNIX-based systems have a special feature in the stty

program. The number of rows in a session window can be set to

any value, and applications programs such as vi learn your

window size from the stty setting. The following command line

sets the window size to 33 lines.

stty rows 33
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Using the special macro variable #, you can create a macro that

issues this command and automatically substitutes the number of

lines for the current window. For example, you could define the

macro for � -0 as the following.

stty rows \#

Now, you can set the window size by pressing � -0 and then

RETURN. The sequence \# is replaced with the proper number of

lines.

See "Defining Macros" in Chapter 2 for information about

creating and saving macros.

NAWS
Telnet 2.5 features "Negotiations About Window Size," or NAWS.

Some UNIX hosts allow the client to send information regarding

the Telnet user's window size. Consequently, when the user

changes the number of useable lines by using the "Set Usable

Lines" dialog box, this new information is sent over the network

to the host. In this case, the user does not need to use the stty

rows operation. The host knows how big the window is, which

straightens out a lot of problems for screen-oriented

applications such as vi. NOTE: this feature is not present on all

UNIX machines. If the host does allow NAWS, then Telnet handles

this feature automatically -- the user does NOT need to do

anything extra.

Select Setup Keys to select which keys issue the telnet commands

Interrupt, Suspend, and Resume (see "Changing the Assigned

Keys for Interrupt, Suspend, and Resume" in Chapter 2.)

Setup Keys

The submenu contained under the Font command contains the

fonts that you may use to display text in a session window. When

you select a font from this submenu, the current window is

resized to contain the text and the selected font is used to display

all text in the current window.

Font

NOTE:  Fonts which are proportionally spaced (most fonts except

Courier and Monaco) display slowly and appear spread out.
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Size This option allows you to change the size of text in the current

window. The submenu contained under the Size command contains

the point sizes that you may use to display text in a session

window. The submenu lists all available sizes, displays a check-

mark next to the current size, and outlines all sizes present in

your system. When you select a size from this submenu, the

current window is resized to contain all the resized text and the

text is redrawn according to be the specified point size.

NOTE:  Sizes which do not appear outlined in the menu must be

scaled by the system software and therefore may be slow and not

as sharply defined as the non-scaled sizes.

The color option only applies to Macintoshes that are color-

equipped. Select Color to change the foreground and background

colors of the current window for both normal text and blinking

text. The Color Selection dialog box appears (Figure 3.7).

Color

To assign a color to text or the background of a session window:

1. Click the box next to the item to which you wish to assign

a color:  Normal Text, Normal Background, Blinking Text, or

Blinking Background. Click OK, or double-click the

appropriate box to call up the Color Wheel dialog box, shown

in Figure 3.8.

2. Select a new color by clicking in the color wheel. The

color you select appears in the top rectangle under the heading

Choose a color.

3. Click OK or press RETURN to enable the color change and

return to the Color Selection dialog box. The box next to the

item you selected in Step 1 reflects the color you chose from

the Color Wheel dialog box.

4. Repeat Steps 1 through 4 to assign colors to other items

in the Color Selection dialog box.

5. Click OK when you have finished choosing colors. The

colors you selected are applied to your current session

window.

For additional information on using the color wheel dialog box,

refer to your Macintosh System Software User's Guide.
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Figure 3.7 Color

Selection Dialog

Box

Figure  3.8 Color Wheel

Dialog Box
Choose a color:

Switch to SLIP
This option allows Telnet to use SLIP for serial connections.  For

more information about SLIP and serial connections, please see

chapter 9, "Serial Communications." Note this item only effects

connections that are through the serial port.

Switch to Serial
When this option is selected, Telnet will use normal serial

connections instead of SLIP.  Once again, this option is strictly
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for serial connections, and does not effect normal telnet

connections.

Capture Session to File
Telnet 2.5 has the new feature of being able to save text from a

session to a file. When this option is selected, all normal text

output that appears on the screen will also be saved to a file that

the user can specify. This functionality turns on when the user

selects this menu item, and turns off when the user deselects the

menu item. As is standard with Telnet, a check will appear in the

menu when this option is selected, to inform the user that the

text from that session is being captured. For information on how

to change the name of the capture file, please see chapter 4 under

the heading "Network-Related Commands:  Configure Network."
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Chapter Overview

This chapter covers some more advanced aspects of the NCSA

Telnet working environment. It describes how to change the

configuration settings, use saved sets, open multiple sessions,

and use telnet options and network-related commands.

Saving Session Characteristics

NCSA Telnet makes it easy for you to begin a telnet session

quickly and efficiently. So that you can login and get right to work

without resetting the special characteristics and configuration of

a connection each time you startup, NCSA Telnet Version 2.4

allows you to save and load sets.

A set is your current configuration. For example, a set consists

of the current macro settings and each session's window location

and size, connected host, window name, scrollback setting, color,

font, font size, and backspace/delete setting.

Saving a Set To save a set:

1. Log in to the desired host as instructed in Chapter 1,

"Getting Started."

2. Customize the session by moving the session window to an

ideal location on the screen, specifying a background or text

color, choosing a font and font size, setting the desired number

of scrollback lines, and choosing the backspace or delete

function for the BACKSPACE (or DELETE) key.

3. Select Save Setfrom the File menu, shown in Figure 4.1. A

directory dialog box appears and prompts you to name the set.

4. Name the set and click Save to implement the current

settings.
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Figure 4.1 File Menu

Using a Saved Set By using sets, you can bypass the startup procedure introduced

in Chapter 1, "Getting Started." Specifically, you do not need to

select Open Connection from the File menu or press � -O to open

a connection, nor do you need to specify the connection host or

window name. These operations are performed automatically

when you load a set.

After loading a set, the session window automatically appears for

the specified host, at the specified location on the screen, with

the specified window name, scrollback setting, color and other

characteristics. The following characteristics are saved in a set:

• session name

• hostname

• port number

• window size and location

• scrollback setting

• backspace/delete setting

• macro definitions

• command key setting

• number of columns

• Tek clear screen setting

• font and font size

• color characteristics

• assigned keys for Interrupt, Suspend, and Resume

To load a set from the Finder, double-click on the set icon or file.

This automatically invokes NCSA Telnet. Figure 4.2 depicts the

set icon for the sample set named Setup One. To load a set from

within the NCSA Telnet application, select Load Set from the File

menu. In the directory dialog box that appears, select and open

the set.

Figure 4.2 Set Icon
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NOTE:  You can edit a set datafile using any editor that can edit

files even if they are not of operating system type TEXT.

Opening Multiple Connections

NCSA Telnet allows you to have multiple connections to a single

host or to several different hosts. To open another connection,

just repeat the procedure for opening a connection (presented in

Chapter 1, "Getting Started") or load a set as instructed in the

section above.

The connection with which you are currently working is the

active session. Generally, its session window appears frontmost

on your desktop.

To switch between active sessions and make the active session

window frontmost, click the session window for the desired

connection or select the associated session name from the

Connections menu (Figure 4.3).

Figure 4.3 Connections

Menu

To activate the next session, select Next Session from the

Connections menu. If you are using command key mode, you can

activate the next session on your desktop by pressing � -N (for

next). Doing so activates the session window directly beneath the

current session window.

NOTE:  If you want to make a session active without having its

window frontmost on your desktop, hold down the OPTION key

while selecting the session name from the Connections menu.

When opening multiple sessions, NCSA Telnet opens new windows

on the screen relative to the number of windows currently

opened. You can specify for these windows to be staggered by just

a few pixels or by the whole window title bar. Activate the latter

option by choosing Preferences from the Edit menu and enabling

the staggered windows box. (See Chapter 3, "Staggered

Windows," for more information).
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Rules forSession Names

When you have multiple connections to a single host, it is useful

to specify session names for the connections other than the

hostname. NCSA Telnet allows you to use any of the following for

session names:

• the full Internet number of the host, such as 192.17.22.20.

• any session name that is in your configuration file. (See your

system administrator for the complete list.)

• any name that can be resolved by the domain-based

nameserver, such as sri-nic.arpa. (See your system

administrator, who can configure NCSA Telnet to use the

domain-based nameserver to look up hostnames.)

• the pound sign (#) followed by the host number the host uses

on your Ethernet, when the destination machine is on the same

Ethernet as the Macintosh (EtherTalk) or the gateway

(LocalTalk). For example, if your Macintosh were machine

192.17.22.20 you could access host 192.17.22.30 by

entering #30. (See your system administrator, who can

determine the host number by the class of addressing and the

subnet mask.)

For information about creating customized sessions or specifying

multiple session names for a given host, refer to Chapter 8,

"System Administrator Information."

NOTE:  Some systems do not use the standard telnet port number

23, MFENET for example. If you need access via the telnet

protocol to a different port number, enter the port number after

the session name when you enter it in the Connection dialog box.

The session name and port number must be separated by one or

more spaces. For example, to open a connection to port 23 of

myhost.network.arpa, you would enter the following in the text

box labeled Session Name.

myhost.network.arpa

The following example demonstrates what you would enter to open

a connection to port number 911 of the same host.

myhost.network.arpa  911

In this release of NCSA Telnet, the MacTCP resolver performs the

domain-name lookup. In this way, NCSA Telnet conforms to the

TCP standard, and simplifies many internal processes. This

feature also allows you to use NCSA Telnet with other TCP

products simultaneously and without conflicts.
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The Connections Menu

You can specify titles other than session names for your session

windows. Doing so allows you to easily distinguish between

multiple sessions and session windows.

To specify a window title, type the name in the Window Name box

that appears in the Connection dialog box when you open a

connection, or enter the name in the Window Name box of the

Configuration dialog box.

NOTE:  If you leave the window name blank when opening a

connection, NCSA Telnet automatically numbers the session. Each

time you open a session, the number increases regardless of how

many sessions are currently open. This algorithm is the same one

used by Microsoft Word and most other commercial packages.

The Connections menu contains the window names for current

connections and relays information about the status of each

session. For example, a checkmark (� ) appears next to the

window name of the active session and a diamond (♦) or a circle

(•) appears next to a session name for a connection that you

attempted to make, but which has not yet been successfully

opened.

Specifically, the diamond indicates that NCSA Telnet is checking

the nameserver, trying to find the session name or hostname. The

circle means NCSA Telnet is trying to open the session. When the

connection is established, the diamond or circle next to the

session name goes away and the session window appears.

Figure 4.4 shows how window names may appear in the

Connections menu and explains the notations used.

pluto

Opening Awaiting Connection

Currently Active Connection

Opening Awaiting Name Resolution

Currently Open Connection

Figure 4.4 Connections

Menu Symbols

NOTE:  If you do not remember the meaning of the symbols used

in the Connections menu, just select the connection in question

from the Connections menu. The Connection Status dialog box

appears and reports the name and status of the connection (see

Figure 4.5). After reading the message, click OK or press

RETURN to proceed opening the connection. Click Abort to cancel

the attempt.
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Figure 4.5 Connection

Status Dialog Box

Aborting Connection Attempts

To abort a connection attempt:

1. Select the connection in question from the Connections

menu. The Connection Status dialog box appears and reports

the name and status of the connection (see Figure 4.5 above).

2. Click Abort.

Telnet Options

Five of the telnet options provided by NCSA Telnet are contained

in the Network menu, shown in Figure 4.6, and are discussed in

the following sections. The Internet standard telnet protocol

defines several special commands which NCSA Telnet supports.

Each host telnet implementation treats these commands

differently, but the commands are supposed to have the functions

described in the following sections.

Figure 4.6 Network

Menu

The Interrupt process command and the other telnet options,

Suspend and Resume, have been assigned special keys which may
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be changed using the Setup Keys command in the Session menu

(see "Changing the Assigned Keys for Interrupt, Suspend, and

Resume" in Chapter 2).

Note that command key equivalents for these commands are only

available if you have selected the Command Keys option in the

Preferences dialog box (see "Using Keyboard Commands" in

Chapter 2).

A new option in the NCSA Telnet 2.4 version concerns File

Transfer Protocol (FTP) commands. NCSA Telnet will not use the

FTP -n option if you hold down the shift key while pressing � -f.

Instead, it will FTP without the -n (see Chapter 5, "File

Transfer," for more information about FTP commands).

Every once in a while, perhaps because the host is bombarded

with incoming information or tied up by a great number of users,

it seems as if the host is not responding to your commands. When

this happens and your terminal appears to have locked up, you

can verify that you are still connected to the host by selecting

Send "Are You There?" from the Network menu or by pressing

� -/.

Send "Are You There?"

The host is supposed to respond, if able, with a readable message.

Some machines answer [Yes]; others answer with more

informative messages. Use this command whenever you are

unsure whether the network and host are up.

The Send "Abort Output" command is supposed to throw away all

output from the currently running process and resume when

there is a pause. Very few hosts implement this command

correctly.

Send "Abort Output"

Available on nearly every telnet host, the Interrupt Process

command stops the current process and throws away all pending

data for the connection. The Interrupt Process command is

equivalent to CONTROL-C on most UNIX systems. NCSA Telnet also

maps CONTROL-C to Interrupt Process. You can change this

mapping using the Setup Keys command in the Session menu (see

"Changing the Assigned Keys for Interrupt, Suspend, and Resume"

in Chapter 2).

Send "Interrupt
Process"

While entering commands, you can erase the last character or the

current line by issuing the Send "Erase Character" and Send

"Erase Line" commands, respectively. Many hosts do not

implement these commands, but use their own special characters

instead.

Send "Erase
Character" and Send
"Erase Line"
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Network-Related Commands

Three of NCSA Telnet's network-related commands appear in the

Network menu, shown in Figure 4.6—Suspend Network, Show

Network Numbers, and Configure Network. The other, Reset

Terminal, appears in the Session menu.

To temporarily suspend all network communications, select

Suspend Network from the Network menu. This action disables all

of the receive functions. All of your connections are kept alive,

but you do not see any incoming text.

Suspend Network

NOTE:  Generally, you will use the Suspend and Resume

commands discussed in the section entitled "Changing the Assigned

Keys for Interrupt, Suspend, and Resume" in Chapter 2, rather

than the Suspend Network command.

If you need to see your AppleTalk address, IP number, Network

Mask, or (for those using EtherTalk) your Ethernet address,

select Show Network Numbers from the Network menu. This

command displays the information in a dialog box, as shown in

Figure 4.7; it does not transmit these numbers. Click on the

message box to remove it.

Show Network
Numbers

144.238.20.101

22001

Figure 4.7 Network

Numbers Dialog

Box

The Configure Network command is intended to be used by system

administrators and knowledgeable users. It is only available

when there are no active connections; that is, no connections are

open, none are pending, and you are not using FTP. Otherwise, the

command appears dimmed and cannot be selected.

Configure Network

Select Configure Network from the Network menu to see the

Configure Network dialog box, which is used when you first

configure the program (Figure 4.8). For more information

regarding configuring the network using the Configure Network

dialog box, consult Chapter 8, "System Administrator

Information."
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Figure 4.8 Configure

Network Dialog Box

Reset Terminal Some host programs can accidentally set graphics mode or fail to

leave graphics mode. If this occurs, select Reset Terminal from

the Session menu. The reset terminal command resets all VT102

mode settings. These settings include disabling wrap mode,

resetting graphics mode, setting the keypad mode back to the

default, and resetting tabs to every eight spaces. To reset the

VT102 screen, select Reset Terminal.

Serial Port Settings
To use the serial port, you must configure it for proper use. To

do this, select the "Serial Port Setting" menu item from the

Network menu. After doing that, you should see the Serial

Settings dialog box, as in Figure 4.9.

Figure 4.9 Serial

Settings Dialog Box

June 1992



4.10 NCSA Telnet

Baud
The baud rate specifies how fast data is transmitted through the

serial line. You will usually want to set this to the maximum

baud of the modem that you are using, which will allow for

maximun speed of data transfer. Select the proper speed by

clicking on the up/down arrows.

Data Bits
Change this control if you want to change the amount of data bits

that Telnet expects for incoming serial data. Older protocols often

specified 5 or 6 data bits, which allowfor faster transmission of

data, but a smaller character set that can be used. Newer systems

typically use 8 data bits, which gives many more possible

characters that can be transmitted. You will need to set this value

to correspond to the number of data bits the host machine is

transmitting.

Parity
This option describes the parity checking scheme that Telnet

uses. The default is "no parity" in which case Telnet does no

internal error checking of the incoming data. The other options

available are to use either an Even scheme, or an Odd scheme, to

check the incoming data for errors. The setting for this will

probably vary depending on the site that you are communicating

with.  You will want to set the parity to be the same as the

transmitted data.

Stop Bits
The number of stop bits controls the start/stop synchronization

of data transfer in serial communication.  This setting most often

depends on the number of data bits. If the data bit setting is for 5

bits, then typically the user will need to set the stop bits value to

1.5. Other possible values are for 1 or 2 stop bits.

Port
You can establish serial connections out of either the modem

port, or the printer port. Set the port you wish to use by setting

this item accordingly.

Handshaking
Handshaking is a protocol for controlling the flow of data from

sender to receiver. If no handshaking is present, the sender just

keeps sending data regardless of how well the receiver is

handling the data, and there is no real synchronization of data

transfer. Telnet offers another protocol, XON/XOFF handshaking,

which is a very simple protocol for data flow control. Use this

option ONLY when the sender is also using this protocol, or

various transmission problems will result.
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SLIP IP#
To use SLIP, you must have an IP number, and you can set this

number in the SLIP IP# text box.

Aliases
Telnet 2.5 features the ability to specify an alias instead of a full

UNIX hostname, when prompted with the Open Connection dialog

box, as shown in Figure 4.10.

Figure 4.10  Connection

Dialog Box

In this case, you can enter an alias such as "yoyo" instead of

typing the full name "yoyodyne.ncsa.uiuc.edu." To preset aliases,

you must use the Alias menu option in the Network Menu (as

diagramed below).

When any name is entered as the "Session Name," this list of

aliases is searched first. If that alias is found, the host name and

port information is automatically registered, and the domain

name lookup continues from there. If no alias is found, then

Telnet just continues with its normal domain name lookup

precudures. In other words, Telnet will always first check to see

if the Session Name is an alias before the connection is opened.

Setting Aliases
To set aliases, choose the Alias menu item from the Network

Menu, which displays the "Add/Remove Aliases" dialox box, as

shown in figure 4.11. To set an alias, specify the full UNIX

hostname in the "host name" space, the port number to connect to

in the "port" space, and finally the alias that you desire in the

"alias" space. This alias will be added to Telnet after you click the

Add button. To remove an alias, click on the name of the alias in

the alias list, which highlights the name, and then hit the Remove

button. The appropriate alias is then removed from the list.

When all desired aliases are specified, click OK to save all of the

current aliases to Telnet. If Cancel is hit, no changes take place,
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and the Aliases will remain as they were before the user selected

the Alias menu item.

NOTE:  This feature allow you to specify the port number to

connect to very easily. This number is just tacked on to the end of

the hostname when Telnet tries to open the session. For instance,

if the alias "sendmail" specifies a host of "yoyodyne" and a port

number of "25", then this is exactly like opening a connection to

"yoyodyne 25" from the Open Connection dialog box -- with the

exception that it saves a lot of keystrokes and does not require the

memory of various port numbers!

Figure 4.11 Add/Remove

Alias Dialog Box
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Chapter Overview

This chapter discusses the various features NCSA Telnet provides

for transferring Macintosh-specific and other files, and

describes the most common File Transfer Protocol (FTP)

commands.

Terminology

The following terms are frequently used in this chapter's

discussions concerning file transfer procedures.

An ASCII, or text, file is one that you can read; it can be used with

standard editors on the Macintosh or host. When text files are

transferred, they are translated to a format appropriate for the

receiving machine.

ASCII File

A binary, or image, file cannot be read by standard text editors.

Unlike text files, binary files are not changed in any way when

transferred.

Binary File

The client is the system that requests services and the server is

the system that provides them. The client is not always your

Macintosh, despite appearances. When you use NCSA Telnet to

connect to a host, your Macintosh is the telnet client. When you

request a file transfer from your Macintosh, the transfer is

actually initiated on the host, making the host the FTP client and

your Macintosh the FTP server. So the Macintosh can be both a

telnet client and an FTP server at the same time.

Client/Server

In a file transfer, the contents of a file are copied to a file on

another computer.

File Transfer

A MacBinary file is a file that has been encoded in the MacBinary

file format. This means that the file contains all of the

information contained in a normal Macintosh file and therefore

can be used for transferring applications and other Macintosh-

specific files. These files are virtually useless on any other

machine, but are in a format that will allow them to be stored for

downloading to a Macintosh later.

MacBinary File
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About FTP

NCSA Telnet has an internal File Transfer Protocol (FTP) server

that allows reliable file transfers between a Macintosh and any

FTP host on the network. File transfers are initiated from the

FTP host. Features of the NCSA Telnet implementation of FTP

permit:

• Stream transferring files in text (ASCII) or binary (image)

format

• Changing the directory (by means of menu option or remote

command line)

• Showing the name of the current directory

• Listing files in the current directory (with wildcard

specifications)

• Sending and receiving multiple files with one command, using

wildcards

NOTE:  File transfers are processed in the background.

Therefore, while a file transfer is in progress you can perform

other NCSA Telnet activities, such as switching sessions, adding

new sessions, or changing parameters. While one FTP connection

is active, requests for another are ignored.

Transferring Files

Before attempting to transfer files using FTP, make sure the

following conditions are met.

• Your host system supports FTP file transfer. If you do not

know whether it does, see your system administrator.

• You have not disabled the file transfer capability of NCSA

Telnet. Two conditions inform you that the FTP capability is

disabled: (1) the FTP Enable command appears unchecked in

the File menu, and (2) your machine will not respond to the

FTP command when you attempt to start up FTP. You can select

FTP Enable, so that the command appears checked. Your

system administrator can also enable FTP in the configuration

file.

FTP is initiated by the remote host, so the FTP commands vary,

depending on the host system. For full documentation of FTP and

commands within FTP, refer to the manuals for the host

computer. With UNIX systems, you can access online

documentation by entering:

Invoking FTP on the
Host Computer
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man ftp

On most systems, you enter the FTP command at the prompt, with

the name or IP address of the target machine. You can enter the

FTP command in one of three ways. For example, if your

Macintosh is named "mymachine" and your IP address is

192.17.20.22, any of the following procedures invokes FTP.

Issuing the FTP
Command

• Enter:

ftp  mymachine

or

ftp  192.17.20.22

and press RETURN.

• Select Send FTP Command from the File menu or press � -F.

NCSA Telnet types the FTP command and issues a RETURN.

• Enter ftp, press the spacebar, select Send IP Number from

the Network menu, and press RETURN. The Send IP Number

Command types your IP address for you.

Use whichever method of invoking FTP with which you feel

comfortable. Your host computer may not accept FTP commands

as described here, so you may have to try some variations to find

the easiest method for your site.

Regardless of the method you use to invoke FTP, most FTP clients

generate a response like this:

Connected to 192.17.20.22.

220 Macintosh Resident FTP server, ready

Name (192.17.20.22:timk):

Most FTP clients prompt you for your username and password. If

NCSA Telnet is configured for passwords (see Chapter 9), then

these are required. Otherwise, just press RETURN to bypass the

prompts. If you are not prompted for a username and password,

assume that you are logged in, and continue to enter your FTP

commands at the FTP prompt.

NOTE:  When an FTP connection is active, the cursor changes to a

small file icon (Figure 5.1). When the FTP connection

terminates, the file icon changes back to the standard cursor, or

I-beam.

Figure 5.1 File Transfer

Cursor
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Using Telpass When you enable FTP (ftp=yes in the configuration file),

anyone can FTP to your computer unless you create a password

file. We recommend you create a password file with Telpass,

which is included in the NCSA Telnet distribution package.

Telpass  is a program that allows you to create an encrypted

password file.

To invoke and use the Telpass application:

1. Double-click the Telpass application icon (Figure 5.2). An 

untitled dialog box (Figure 5.3) appears on the screen.

Figure 5.2 Telpass Icon

Figure 5.3 Telpass

Dialog Box

2. Click the New User button. A dialog box stating Enter new

username appears.

3. Type in a username consisting of 1-12 alphanumeric

characters.

4. Click OK. The untitled dialog box reappears, this time

containing your alphanumeric username followed by a colon.

5. Select the username. Notice that the Set Password and

Delete buttons become activated (Figure 5.4).
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Figure 5.4 Sample

Telpass Entry

6. Click the Set Password button. A new dialog box appears

and asks you to enter a password (Figure 5.5).

Figure 5.5 Password

Dialog Box

7. Type a password consisting of 1-12 alphanumeric

characters.

8. Click OK. The untitled dialog box appears again. Notice a

triangle, representing your password, appears after the

username.

9. Repeat steps 2-8 to enter additional usernames and

passwords.

10. Select Save As from the File menu. A directory dialog box

appears (Figure 5.6). Enter your password filename in the

box labeled Save password file as, and click Save.
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Figure 5.6 Directory

Dialog Box

11. Include the following in your configuration file:

ftp=yes
passfile="filename"

where filename is the name of the encrypted file created in

Telpass.

If the passfile is not located in your System Folder, you must

include the filename as a full path name.  For example:

passfile="hd40:NCSA Telnet:filename"

NOTE:  Editing the config.tel file while the program is running

has no effect on the program's operation. To activate the changes,

you must restart NCSA Telnet.

To test your password file:

1. Log on to a host that runs software that supports the FTP

command.

2. Invoke FTP (on most systems) by entering the FTP IP

number of your MacIntosh (or press COMMAND-F).

3. Type any command such as 'ls'. You'll receive the message:

USER and PASS required to activate me

4. Enter the word user, then enter your username and

password from the Telpass file.

The following is an example of a sample session (where username

and password were in the Telpass file as a username and

password, respectively):
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yoyodyne_51%  ftp -n 128.174.221.167
Connected to 128.174.221.167

220 Macintosh Resident FTP server, ready

ftp> ls
530 USER and PASS required to activate me

530 USER and PASS required to activate me

ftp> user username password
331 password required

230 User logged in

ftp> quit
221 Goodbye

yoyodyne_52%

NOTE:  If you don't want someone to read your password, do not

enter the password on the first line. A 'Password required'

prompt appears. You can then type in your password and the

machine will not echo it back.

Once you finish entering and testing usernames by using Telpass,

you can continue with FTP commands.

After FTP has been invoked and passwords have been checked,

most FTP clients prompt you for individual FTP commands. These

commands are documented in the manuals for the host computer.

Most FTP implementations have similar commands because they

are modeled after the Berkeley UNIX version of FTP.

FTP Commands

FTP commands that are common to most implementations are

listed in Table 5.1 and are described in the following sections.

Once you are in FTP, you can access online help for a list of

available commands.

Command Action
ascii set mode to ASCII transfer mode (default)

binary set mode to binary (image or I) transfer mode

Table 5.1 Common FTP

Commands

cd change directory on your Macintosh

dir show filenames in Macintosh's default directory

get filename get file from Macintosh, send it to the host

help show online list of FTP commands

put filename send file from the host to the Macintosh

pwd show the current Macintosh directory name

The boldface type in Table 5.1 represents user entries.

To help you keep track of file transactions, NCSA Telnet shows

current and past transactions in the FTP log, shown in Figure

5.2. To view the log, select Show FTP Log from the File menu.

FTP Log
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Figure 5.7 Sample FTP

Log

Setting the Transfer
Mode

The default mode for FTP transfers is ASCII format. To transfer

graphic or binary data files, you must change the transfer mode

to binary format before using the put or get commands. To set the

transfer mode to binary, enter the command binary or bin.

If you intend the file you are transferring to be used with a

Macintosh-specific application, you may also need to enable the

MacBinary Enabled option in the File menu by selecting it. The

command appears checked in the menu when it is enabled (see

this chapter's section, "Transferring MacBinary Files").

To set or reset the transfer mode to ASCII format, enter the

command ascii.

For example, Figures 5.3 and 5.4 in this chapter's section,

"Transferring Files to the Macintosh," shows an FTP transaction

with an ASCII file and binary file, respectively.

FTP transfers files to the default directory on the local disk. To

change the directory, issue the cd command from FTP or select

Set Transfer Directory from the File menu and locate the

directory in the dialog box that appears. For more information

regarding using directory dialog boxes to locate files and change

directories, refer to your Macintosh user's guide.

Changing the Default
Directory

The cd command from FTP, as shown in Table 5.1, has the

identical effect as the Set Transfer Directory command, though

you specify a directory by manually entering a path rather than

using a dialog box. To specify a directory using the cd command,

use the colon (:) or the forward slash (/) to separate folder

names, as the Macintosh requires. For example, to change the

default directory to myfolder on your local Macintosh disk hd20,

you would enter one of the following commands at the FTP prompt

(ftp>).

cd ":hd20:myfolder"

or
cd "/hd20/myfolder"

To find out what directory is set as your default transfer

directory, enter pwd at the FTP prompt. For example, if you

enter pwd after issuing the sample cd command above, the return

is:
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"/hd20/myfolder" is the current directory

Transferring Files to
the Macintosh

Even though you seem to be initiating the transfer from the

Macintosh, the transaction actually operates from the host's side.

The practical effect of this arrangement makes the commands

seem intuitively "backward." For example, to transfer a file

from the host to your Macintosh, you do not use a get command as

you might expect, but a put command of the following form.

put filename.ext

Figure 5.3 shows an example of using the put command to

transfer the file temp2 from a host to a local Macintosh. The

boldface type represents user entries.

newton_45% ftp -n 192.17.20.124
Connected to 192.17.20.124.

220 Macintosh Resident FTP server, ready

ftp> put temp2
200 This space intentionally left blank <  >

150 Opening connection

Figure 5.8 Transferring

an ASCII File to the

Macintosh

226 Transfer complete

262145 bytes sent in 32.61 seconds (7.8 Kbytes/s)

ftp> quit
221 Goodbye

newton_46%

NOTE:  Do not exit the program while a file transfer is in

progress, or the file transfer will fail.

A request to send a file from the Macintosh to the host requires a

get command of the following form.

Transferring Files to
the Host

get filename.ext

Figure 5.4 shows a get operation used to transfer a binary file

named bridge.pic from a local Macintosh to the remote host.

Note that the file was in the directory /HD20/pictures, and the

cd command was used to locate that directory. Again, the boldface

type represents user entries. If you were to send a text file after

this sample transfer is complete, you would have to reset the

transfer mode to ASCII by first entering ascii.
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Figure 5.9 Transferring

a Binary File from

the Macintosh to a

Remote Machine

newton_41% ftp -n 192.17.20.124
Connected to 192.17.20.124.

220 Macintosh Resident FTP server, ready

ftp> bin
200 Type set to I, binary transfer mode

ftp> cd "/hd20/pictures"
250 Chdir okay

ftp> get bridge.pic
200 This space intentionally left blank < >

150 Opening connection

226 Transfer complete

262144 bytes received in 9.22 seconds (28 Kbytes/s)

ftp> quit
221 Goodbye

newton_42%

Transferring Multiple
Files

Some versions of FTP enable you to transfer multiple files

sequentially with one command, either mput or mget, used with

wildcard characters.

WARNING:  If you transfer multiple binary files using a UNIX

host, note that there is a bug in mget as implemented on some

systems (especially 4.2 BSD UNIX). When used in binary mode,

mget adds a carriage return to the filenames as they are

transferred. The files themselves are not affected. Use a UNIX

utility to remove the carriage return from the filename. In ASCII

mode, mget causes no problem.

The trick to using wildcards in FTP get commands is to enclose

the get commands in quotes, for example, get "*.image". Do not

use quotes with put commands.

Transferring
MacBinary Files

Sometimes it may be necessary to upload Macintosh-only files to

non-Macintosh hosts and later download them without losing any

of the Macintosh-specific data, such as icons and the creation

date.

To transfer Macintosh-only files (such as applications and most

data files) to an intermediate host while retaining any

Macintosh-specific information contained in the files:

1. Enable the MacBinary Enabled option in the File menu. A

checkmark appears next to the command when it is enabled.

You can alternately enable and disable MacBinary by selecting

this option. (Since MacBinary is a binary-only transfer

protocol, it is only available when FTP is in binary mode.)

Now, all get and put commands transfer Macintosh files in

MacBinary format.

2. Set the file transfer mode to binary by entering binary

or bin at the FTP prompt.

NOTE:  If you are writing host-based scripts to download or

upload to a Macintosh in MacBinary mode, you can use the quote
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MACB ENABLE and quote MACB DISABLE commands from the host's

FTP client to enable and disable MacBinary mode, respectively.

Resetting MacBinary
for Each FTP

NCSA Telnet can save you the trouble of tracking whether the

MacBinary Enabled option is checked or unchecked in the File

menu each time you want to transfer files. To set MacBinary

mode to return to the default setting of your preference, enabled

or disabled, whenever you begin a new FTP session:

1. Select Preferences from the Edit menu. The Preference

dialog box appears.

2. Enable the option Reset MacBinary for each FTP.

3. Enable or disable the MacBinary option to indicate

whether you want MacBinary mode to be reset to enabled or

disabled, respectively, whenever you begin an FTP session.

Doing so ensures that for each new FTP session that you

initiate, MacBinary mode is set to your preference by default,

regardless of how you set the mode in a previous FTP session.

NOTE:  "Each FTP" corresponds not to the individual file

transfer, but to establishing the FTP command connection.

4. Click OK or press RETURN to apply these options only to

the current session with NCSA Telnet. Click Save to save the

specifications as the default, so that next time you invoke NCSA

Telnet, it activates the option automatically.

FTP Client
Telnet 2.5 includes the ability to connect directly to the FTP port

of a host machine, allowing the user to transfer a file directly

between the host machine and Macintosh. To transfer a file from a

remote machine to a Macintosh, normally the user need to:

1. Log into any UNIX account

2. Transfer the file from the remote host to the user's UNIX

account via FTP.

3. Transfer the file from the user's UNIX account to the

Macintosh via FTP.

This procedure obviously necessitates the need for the direct

transfer of files from a UNIX host to the Macintosh. This removes

the need to log into any secondary UNIX account, which is used as

a temporary go-between for FTP.
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Logging in to the FTP
Client

To start an FTP client session, select the "FTP Session" button in

the Open Connection dialog box. A window will open up displaying

a connection message, similar to that of Figure 5.10.

NOTE:  Selecting the "FTP Session" button is the exact same as

opening a connection to the UNIX machine on port 21, which is

the FTP port.  Therefore, the user can set up an alias to a

machine with port 21, and all sessions opened to that alias will

be ftp clients.  For more information about aliases, please see

Chapter 4.

Figure 5.10 FTP Client

Connection

To use the FTP client, you must first log into the server.

1. Enter "user" followed by your login name, and press

RETURN. The host will send a message prompting you to enter

your password. Example:

user name RETURN

2. Enter your password and press RETURN.

3. If you are logged in, the host will send back a message

saying that you are connected properly.

Once logged in, you can use the FTP client in the same way as you

would normally use an FTP session.
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Tektronix 4014 Emulation 6.1

Chapter Overview 

This chapter describes the scope of NCSA Telnet's Tektronix

4014 and 4105 emulation capabilities, and explains how to

conduct Tektronix graphics emulation sessions and operations in

graphics windows.

Tektronix Graphics Emulation

NCSA Telnet can emulate the Tektronix 4014 and 4105

terminals. This emulation includes text modes, Tektronix 4014

or 4105 text sizing, zoom, and pan. The use of Tektronix

graphics with NCSA Telnet depends on host programs that can

produce graphic images. When these programs run and produce

Tektronix 4014 or 4105 graphics commands, NCSA Telnet

automatically switches into graphics mode, opens a graphics

window, and does the drawing.

The tektype field in the config file can be set to either 1 for 4105

or 0 for 4014. If this field does not exist in the config file, then

you will be presented with a dialog box (figure 5.1)  whenever

you either select TEK page or begin to receive Tek codes from the

network.

Getting Started

Figure 6.1 TEK Dialog

Box

NOTE:  If you wish to change the specified tektype, you must

select the TEK mode from the Configuration dialog box when you

first open a session.

A host program generates the Tektronix clear screen character

sequence (ESC, FF) over a currently open connection. When

NCSA Telnet receives this command, a graphics window opens. All

graphics output from this session is redirected into that window

until you close it or the TEK end command is sent.
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Using TEK Page The TEK Page command in the Session menu provides a quick way

to create a Tektronix emulation window without requiring

intervention from host software. Normally the emulation window

appears automatically upon receiving the clear screen command

sequence from the host. You can, however, select the TEK Page

command to create the window immediately.

Moreover, just as you would use the Page key on a real Tektronix

terminal to clear the window for the current session, you can

select TEK Page to clear a graphics window.

Graphics Window Operations

NCSA Telnet allows you to detach, delete, zoom, print, and copy

graphics windows as described in the following sections.

To detach a graphics window, click on the text window for that

graphic's connection. To click on a window without detaching its

corresponding graphics window, hold down the OPTION key while

you click. When a window is detached its title no longer contains

the (•) character that identifies it as the active output window.

Detaching a Graphics
Window

The window may be detached under the control of host software,

also. The CAN character (dec 24), when received, resets the

terminal to the VT102 screen emulation.

To remove a graphics window, click on its close box.Deleting a Graphics
Window

To magnify a portion of the drawing in a graphics window, drag a

selection rectangle around the area to be viewed more closely.

When you release the mouse button, the selected section of the

drawing expands to take up the entire window. The selections

always maintain the aspect ratio of the TEK window. This

requirement prevents the distortion or stretching of the TEK

image.

Zooming/Unzooming a
Graphics Window

To return the magnification to zero (and thus see the entire

drawing), double-click anywhere in the window. Figures 6.2 and

6.3 show pictures of the same drawing in windows at normal and

zoomed magnification, respectively.

You can copy and print the contents of zoomed or unzoomed

windows. (When you copy or print a zoomed window, only the

visible portion of the window is copied or printed.)
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Figure 6.2 Normal

Tektronix Image

Figure 6.3 Zoomed

Tektronix Image

To copy the contents of a graphics window onto the Macintosh

Clipboard, activate the window by clicking on it and choose Copy

from the Edit menu. Now you can paste the graphic into another

Macintosh application.

Copying a Graphics
Window
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Printing a Graphics
Window

To print the contents of a graphics window on a local printer or a

printer on the AppleTalk network, activate the window by

clicking on it and choose Print Selection from the File menu.

NCSA Telnet centers and scales all graphics to fit the page. To

achieve the greatest resolution on a LaserWriter, set the Reduce

or Enlarge option in the Page Setup dialog box to 25 percent

(Figure 6.4). This setting does not change the size of the image,

but makes the lines thinner. For more information about the Page

Setup dialog box, refer to your Macintosh user's guide.

25

Figure 6.4 Page Setup

Dialog Box
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Interactive Color Raster Graphics 7.1

Chapter Overview

This chapter introduces the Interactive Color Raster (ICR)

protocol and describes how you may use this protocol in your

programs to display color graphics with NCSA Telnet. In addition,

the chapter describes how to control raster graphics windows,

and display and manipulate color images. The chapter includes an

example program that you may use as a template for designing

programs that use the ICR protocol.

Interactive Color Raster Graphics

Interactive Color Raster (ICR) is a protocol for displaying raster

graphics on your workstation screen. The ICR protocol controls

its own windows through NCSA Telnet. It shares characteristics

of the Tektronix graphics terminal emulation protocol. For

example, escape sequences are used to control the display.

Using ICR, you can write mainframe programs to display color

images in their own windows on your Macintosh screen, and you

can apply the full range of 256 colors out of a palette of 16

million colors to your graphics displays. The ICR protocol is

intended for use on a Macintosh with 256-color capability.

Starting and Quitting ICR Graphics Emulation

To use ICR, you need a program that runs on the remote, or host,

computer which gives all of the appropriate commands to conduct

the ICR graphics emulation. To create an ICR program, work

from the protocol description contained in this chapter's section,

"Using the ICR Protocol" and the example program contained in

the section, "Example Program for ICR in C."

When the protocol command for creating a window arrives from

the host, NCSA Telnet creates a Macintosh window for it. All

human-readable text continues to go to the VT102 window and the

graphics commands are sent to the proper graphics window.

The ICR program on the remote computer may choose to take the

window away itself. If it does not, you can dispose of a graphics

window by clicking in the close box, which is located in the

upper-left corner of the window's title bar. If you exit NCSA

Telnet while some windows remain open, the windows close

automatically.
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Using the ICR Protocol

To use ICR, you write a program that issues graphics commands

to NCSA Telnet. NCSA Telnet receives these commands, interprets

them, creates or destroys windows, sets the color environment,

or displays raster graphics as the program directs.

To ensure that NCSA Telnet can determine the difference between

regular text and ICR graphics, begin all ICR graphics sequence

commands with the escape sequence ESC^ (escape, caret).

Each ICR command has the form:Description of the
Protocol

ESC^X; parameters ^ data

where

• X is one of the command characters listed in Table 7.1 and

fully described in Table 7.2.

• ^ is the caret character (ASCII 94).

• parameters is one or more of the parameters of X. The

parameters for each command are listed in Table 7.1.

• the command is terminated with a caret (^).

• each command may be followed by a data stream which goes

with it.

The parameters are determined by the command character that is

used (Table 7.2). If your program omits the parameters, then

NCSA Telnet supplies default values for the parameter values.

Parameters are always printable ASCII and are delimited by ';'.

For commands that require data, the data follows the command.

Command Operation
W Creates a window

D Destroys a window

M Loads a color map palette of up to 256 colors from

a 24-bit palette into the graphics window

R Indicates that run-length encoded data follows

P Indicates that pixel data follows

I Indicates that IMCOMP compressed data

(4:1 compression) follows

Table 7.1 ICR

Commands
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Table 7.2 Commands and Command Parameters

Described

Command Parameters Description

W Creates a window at the given location on the screen,

where 0, 0 is the upper-leftmost corner of the

screen.

• Left, top, width, and height are integers specifying

a location and size on the screen (see Figure 7.1).

• Display is an integer indicating the hardware

screen number (for machines with more than one

screen—the parameter is not applicable for

Macintoshes).

• Windowname is a string used to distinguish multiple

windows. The windowname assigned to a window is

used by all of the other commands to specify which

window to use.

left; top; width; height;

display; windowname

Destroys a window by physically removing it from the

screen and memory.

• Windowname is the unique name assigned to a

window when it is created by the W command.

windownameD

start; length; count;

windowname

M Loads a color map or portion of one into the display

hardware. NCSA Telnet assumes that palette entries

are 8-bit R, G, and B, 3 bytes per entry, in that

order. The default palette is a straight grey-scale

ramp, where 0=black and 255=white. (See the section

entitled "Color Maps.")

• Start is an integer indicating the first entry to

change.

• Length is an integer indicating the number of

entries to change.

• Count is an integer indicating the total number of

bytes that are in the data portion. Count is followed

by the data for the command.

Specifies that the data to follow is run-length encoded.

(See the section entitled "Run-Length Encoding

Format.")

• x, y are integers indicating the point where the

raster line starts and the data follows for length

bytes of encoded data.

• Expand is an integer indicating the number of times

each dimension is to be expanded on the local

screen. For example, an expand value of 2 makes

the picture four times larger.

• Length is an integer indicating the encoded length of

the data, in bytes.

x; y; expand; length;

windowname

R
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P x; y; expand; length;

windowname

Specifies that the data to follow is pixel data.

• x, y are integers indicating the point where the

raster line starts and the data follows for length

bytes of pixel data.

• Expand is an integer indicating the number of times

each dimension is to be expanded on the local

screen. For example, an expand value of 2 makes

the picture four times larger.

• Length is an integer indicating the length of data, in

bytes, which is the same as the number of pixels to

be displayed.
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Table 7.2 Commands and Command Parameters Described

(Continued)

Command Parameters Description

I Specifies that the data to follow is  encoded with the

IMCOMP compression scheme. The M command MUST

be used before the picture displayed with the I

command will appear correctly.

• Length is an integer indicating the number of pixels

per line, though one 'I' call represents four lines of

data. The IMCOMP compression is a 4x4 SQUARE

compression scheme, so each "line" of data will

appear as four lines of pixels on the screen.

• Y is required to increment the line numbers by

fours:  0, 4, 8, 12, 16, etc.

x; y; expand; length;

windowname

Figure 7.1 Meaning of the Left, Top, Width, and Height

Parameters

top the pixel value of the vertical, or y, location of the upper-left corner of the graphics window

left the pixel value of the horizontal, or x, location of the upper-left corner of the graphics window

height the number of pixels that comprise the vertical height of the graphics window

width the number of pixels that comprise the horizontal width of the graphics window

Integer Meaning width

left

top

height

•

NCSA Telnet assumes that all of the parameter values are

printable ASCII except ESC, which is an allowable exception on

most login data streams. This means that the parameters require

no special encoding, but the data values need help.

ASCII Encoding

Your ICR program must encode 8-bit data values into printable

ASCII for transmission. When possible, the values that fall in the

printable ASCII range are passed untouched and all values outside

that range are encoded as two bytes.
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The following encoding works for all characters 0–255, as shown

in Table 7.3.

Input: realchar

Transmission: specialchar followed by transchar

Encoding: specialchar=realchar div 64 + 123

transchar=realchar mod 64 + 32

Decoding: realchar=(specialchar – 123)*64 + (transchar –

32)

Special Range
123 0–63

124 64–127

125 128–191

126 192–255

Table 7.3 Encoding

Data Values into

Printable ASCII

Because all encoded characters are preceded by a char in the

range 123–126, all regular characters that are 32–122

(inclusive) can be sent without encoding.

Warning:  On CTSS, trailing spaces are trimmed. Consequently,

the values 0, 32, 128, and 192 should be avoided, because they

code to <special> <space>.

NOTE:  In the specifications, all data lengths and counts refer to

the protocol data, not the ASCII encoded data. The length fields for

R, P, and M all reflect the length of the data on the originating

machine before it is encoded.

The data for the run-length encoded line is first run-length

compressed and then ASCII encoded. The process for deciphering,

therefore, is first to decode the ASCII to binary and then to decode

the run-length binary data.

Run-Length Encoding
Format

Using all eight bits of the byte stream which represents the

pixels in a given RLE line, start with the control character. (n)

is the low seven bits of the byte. The high bit represents whether

the following (n) characters are reproduced exactly (high

bit=0) or whether the following single character is reproduced

(n) times (high bit=1).

Input: 1  1  1  1  23  23  23  234  112  33  44  55  42  42

42  42

Tokenized: (128+4)  1  (128+3)  23  (5)  234  112  33  44  55

(128+4)  42

Alternate count, data, count,data

After coding into this tokenized form, the data length for the R

command is known. (The length is 12 in this example). Even

though the ASCII encoding takes place after this step, use the

length value from this step.
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ASCII result: 125  36  123  33 125  35  123  55  123  37

126  74  112  33  44  55  125  36  42

Color Maps You can manipulate the color table for the local display with the

M command. The format for the color map data is a series of color

map entries. Each color map entry is three bytes, one Red, one

Green, one Blue. For example, to set entries 3 through 7 of the

color table, the following M command might be used:

ESC^M;3;4;12;wind^RGBRGBRGBRGB

where the RGBRGB... data is the list of byte values for the new

entries in RGB order. The actual data transmitted over the line

still has to be ASCII encoded, but the data starts out in this form.

Note that the count field, which is 12 in this example, is always

exactly three times the length value, which is 4 in this example.

ICR Graphics Windows

Raster graphics windows require a lot of memory—one byte for

each pixel in each graphics window on the screen. If there is

insufficient memory remaining to open a new window, NCSA

Telnet informs you with an alert dialog and does not create the

window.

If you are using MultiFinder, you can set NCSA Telnet's allocated

memory size to a larger value to prevent running out of memory.

For example, if you need space for two 256x256 image windows,

you need to increase the memory for NCSA Telnet by 128K—256

bytes times 256 bytes (or 64K) for each window.

Allocating Memory

You can copy the contents of an ICR window onto the Macintosh

Clipboard, and paste it into a program that is capable of pasting

color images.

Copying a Graphics
Window

To copy the contents of a graphics window:

1. Click in the graphics window to make it frontmost.

2. Choose Copy from the Edit menu. Now you can paste the

graphic into another Macintosh application.
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System Color
Problems

Image windows utilize the colors available for display on your

Macintosh screen. When you close graphics windows, the system

does not always restore the color environment to its original

state, causing other windows to appear with incorrect colors. We

are currently working to minimize the effects of NCSA Telnet and

ICR graphics on your system's color table.

NOTE:  Pressing CONTROL-C, or other methods of interrupting

ICR commands, may make NCSA Telnet appear to "lock up" (see

also "Telnet Options" in Chapter 4). When this occurs, press

RETURN several times or enter commands until the VT102

window resumes activity. It may help to remember that when a

drawing command is issued, NCSA Telnet expects an influx of a

certain number (often hundreds) of bytes of image data to be used

to finish drawing the current line.

Example Program for ICR in C

The sample program shown in Figure 7.2 is included on the

distribution disk. It produces a test pattern on your screen if you

are running an active ICR-equipped NCSA Telnet. If you do not

have ICR, it produces thousands of encoded characters on your

display.

Figure 7.2 Sample C

Program
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/*   icrtest

*

*  Produces a test pattern on an ICR compatible display. Demonstrates and provides example

*  code for writing ICR programs.

*

*  National Center for Supercomputing Applications

*  University of Illinois, Urbana-Champaign

*

*  by Tim Krauskopf

*  This program is in the public domain.

*

*/

#include <stdio.h>

int

xdim=0,ydim=0;  /* size of image on disk */

char

*malloc(),

*testimage,

rgb[768]; /* storage for a palette */

main(argc,argv)

int argc;

char *argv[];

{

register int i,j;

register char *p;

puts("Creating test pattern");

xdim = 150;

ydim = 100;

if (NULL == (testimage = malloc(xdim*ydim)))

exit(1);

/*
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Figure 7.2 Sample C Program (Continued)

*  Make the test image in a strange pattern.

*/

p = testimage;

for (i=0; i<ydim; i++)

for (j=0; j<xdim; j++) {

*p++ = 50 + (((i & 0xfffffff8) * (j & 7))>>2);

}

puts("Displaying test pattern with the Interactive Color Raster protocol");

rimage(0); /* display remote image with [palette] */

}

/*****************************************************************************/

/*  rimage

*  Remote display of the image using the ICR.

*  Just print the codes to stdout using the protocol.

*/

rimage(usepal)

int usepal;

{

int i,j,newxsize;

char *space,*thisline,*thischar;

register unsigned char c;

/*

*  Open the window with the W command.

*/

(void)printf("\033^W;%d;%d;%d;%d;0;test window^",0,0,xdim,ydim);

/*

*  If a palette should be used, send it with the M command.

*/

if (usepal) {

(void)printf("\033^M;0;256;768;test window^");  /* start map */

thischar = rgb;

for (j=0; j<768; j++) {

c = *thischar++;

if (c > 31 && c < 123) {

putchar(c);

}

else {

putchar((c>>6)+123);

putchar((c & 0x3f) + 32);

}

}

}

/*
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Figure 7.2 Sample C Program (Continued)

*  Send the data for the image with RLE encoding for efficiency.

*  Encode each line and send it.

*/

space = malloc(ydim+100);

thisline = testimage;

    for (i = 0; i < ydim; i++) {

        newxsize = rleit(thisline,space,xdim);

thisline += xdim; /* increment to next line */

        (void)printf("\033^R;0;%d;%d;%d;test window^",i,1,newxsize);

        thischar = space;

        for (j = 0; j < newxsize; j++) {

/***********************************************************************/

/*  Encoding of bytes:

*

*  123 precedes #'s 0-63

*  124 precedes #'s 64-127

*  125 precedes #'s 128-191

*  126 precedes #'s 192-255

*  overall:  realchar = (specialchar - 123)*64 + (char-32)

*            specialchar = r div 64 + 123

*            char = r mod 64 + 32

*/

/***********************************************************************/

c = *thischar++;      /* get byte to send */

if (c > 31 && c < 123) {

putchar(c);

}

else {

putchar((c>>6)+123);

putchar((c & 0x3f) + 32);

}

        }

 }

free(space);

}

/********************************************************************/

/*  rleit

*

*  Compress the data to go out with a simple run-length encoded scheme.

*

*/
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Figure 7.2 Example C Program (Continued)

rleit(buf,bufto,len)

int len;

char *buf,*bufto;

{

register char *p,*q,*cfoll,*clead;

char *begp;

int i;

p = buf;

cfoll = bufto; /* place to copy to */

clead = cfoll + 1;

begp = p;

while (len > 0) { /* encode stuff until gone */

q = p + 1;

i = len-1;

while (*p == *q && i+120 > len && i) {

q++;

i--;

}

if (q > p + 2) { /* three in a row */

if (p > begp) {

*cfoll = p - begp;

cfoll = clead;

}

*cfoll++ = 128 | (q-p); /* len of seq */

*cfoll++ = *p; /* char of seq */

len -= q-p; /* subtract len of seq */

p = q;

clead = cfoll+1;

begp = p;

}

else {

*clead++ = *p++; /* copy one char */

len--;

if (p > begp + 120) {

*cfoll = p - begp;

cfoll = clead++;

begp = p;

}

}

}

/*

*  fill in last bytecount

*/

if (p > begp)

*cfoll = 128 | (p - begp);

else

clead--; /* don't need count position */

return((int)(clead - bufto)); /* how many stored as encoded */

}
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System Administrator Information 8.1

Chapter Overview

This chapter contains information for system administrators and

other experienced users to use in installing and customizing a

system. Specifically, the chapter discusses the Configure

Network Parameters dialog box, the config.tel file, the domain

name lookup feature, passwords for FTP, and compatibility

issues.

NCSA Version and MacTCP Version

In versions 2.3 and 2.4, NCSA Telnet was split into two

versions—the MacTCP version and NCSA version. The MacTCP

version is dependent on the Apple MacTCP drivers for its

networking capabilities. The NCSA version, on the other hand,

has all of the networking built into the application. Reliance upon

MacTCP drivers is important for the growth of TCP/IP use on the

Macintosh for two reasons: (1) it places the responsibility of

networking code where it belongs—as part of the manufacturer's

system software efforts, and (2) it allows much more flexibility

for applications designers. By relying upon MacTCP drivers,

developers can split applications into more manageable pieces

that all run under MultiFinder. For example, a client News

Reader application can now be run under MultiFinder along with

NCSA Telnet.

Starting with this release of Telnet, the two versions are

contained in one single module. This alleviates the need for having

and supporting two separate versions of essentially the same

program. Therefore we will still continue to support our own

TCP/IP drivers in the new version of NCSA Telnet, along with the

MacTCP drivers -- all in one program.

The minor differences in configuration for the two drivers are

documented throughout this chapter. Since the two versions are

now bundled as one single program, all other features of NCSA

Telnet remain identical.

Configuring Network Parameters

To use the NCSA Telnet Configure Network Parameters dialog box

(shown in Figures 8.1 and 8.2) to set up copies of NCSA Telnet

for each Macintosh on the network:

1. Copy the software to the hard disk or floppy disk where it

will be run for each machine.

2. Set up the networking parameters for each Macintosh.
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When you run NCSA Telnet for the first time, the Configure

Network Parameters dialog box should appear automatically; if it

does not, select Configure Network from the Network menu.

If you are using the NCSA drivers, you should enter the IP

number for the machine, the subnet mask, and the default host.

For the MacTCP drivers, just set the default host in the Configure

Network Parameters dialog box. Set up the other networking

parameters using the Control Panel item for MacTCP. You must

correctly set these up before NCSA Telnet will work.

NOTE:  The setting of built-in AppleTalk versus EtherTalk in the

Control Panel does not affect NCSA Telnet; however, you must

install the EtherTalk-compatible driver in the system file for

the Ethernet device to be used.

Figure 8.1 Configure

Network

Parameters Dialog

Box (MacTCP

Drivers)

Figure 8.2 Configure

Network

Parameters Dialog

Box (NCSA Drivers)
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Assigning an Internet
Number (NCSA
Drivers)

For the NCSA drivers, the first step in configuring your copy of

NCSA Telnet is setting the IP number. You should assign the IP

number in one of the four ways described in the following

sections, depending on two factors:  (1) whether the serving

gateway is using direct Ethernet (via EtherTalk), the Croft

gateway software, or the Kinetics gateway software, and (2)

whether dynamic numbers or static numbers are to be used.

Static IP Numbers
(EtherTalk, Croft, or
Kinetics)

To use static IP numbers on an EtherTalk, Croft, or Kinetics

network configuration:

1. Select the radio button labeled IP Number.

2. Enter your four-byte internet address with a period (.)

between each of the decimal numbers (for example,

192.17.20.10) in the text box labeled IP Number.

3. Click OK.

The specified address is saved as the IP number in the NCSA

Telnet Settings file in your System Folder. You need only change

the IP number when your machine's internet address changes

(which it should not do frequently).

This section covers dynamic IP addressing for EtherTalk, Croft,

and Kinetics gateway software.

Dynamic IP Addressing

RARP (EtherTalk)

NCSA Telnet for the Macintosh is capable of retrieving assigned

IP numbers from a network administration machine running the

Remote Address Resolution Protocol (RARP) daemon. The RARP

daemon is documented in the manuals for the host which is

running the RARP server, and the protocol is documented in

RFC903. Their availability is dependent upon your network

configuration and the software running on the hosts on your

network. If you have a UNIX host, you will find the RARP

documentation under the name rarpd in section 8 of the manual.

If you have a machine that can provide RARP service, just enter

the Ethernet address of the Macintosh and its corresponding IP

number into the RARP database and your server should be ready.

NOTE:  If you are using a UNIX RARP daemon, you need to make

sure that the Ethernet numbers are not zero-filled. For example,

8:0:89:f0:5:0 is appropriate; 08:00:89:f0:05:00 is not.

If your network uses RARP dynamic IP addressing, then select

the radio button labeled Assign Dynamically in the Configuration

dialog box.
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To view the IP address, choose Show Network Numbers from the

Network menu (see "Network-Related Commands" in Chapter 6).

Administered (Croft)

The Croft gateway software (which runs in the Kinetics FastPath

and is also known as the KIP software) and the K-Star gateway

software from Kinetics allow for administered dynamic IP

assignment. The assignment can either be unique to each copy of

the program and for each machine or can be dynamic.

If your network uses dynamic IP addressing, select the radio

button labeled Assign Dynamically in the Configuration dialog

box.

AppleTalk-Based (Croft or Kinetics)

To address the IP number dynamically using the AppleTalk

address as a basis:

1. Select the button labeled IP Number.

2. Type in the IP number in the normal location,

substituting the codes presented in Table 8.1 where

appropriate.

Code MeaningTable 8.1 Dynamic IP

Codes

h High-order byte of the network number (Net Number/256)

l Low-order byte of the network number (Net Number mod

256)

n AppleTalk node number

For example, Table 8.2 demonstrates the results of substituting

codes in three sample addresses.

IP # AppleTalk # Resultant IP#
128.174.h.n Net: 1230 Node: 35 128.174.4.35

128.174.20.n Net: 1230 Node: 35 128.174.20.35

Table 8.2 Sample

Dynamic  IP

Assignment

128.h.l.n Net: 1230 Node: 35 128.4.206.35

NOTE:  This method of dynamic addressing is expressly

prohibited on EtherTalk, because AppleTalk is not initialized by

NCSA Telnet when running over EtherTalk.

If your site uses a subnetted network (as specified in RFC950:

Internet Subnetting):

Internet Subnetting

1. Check the box labeled Use Subnetting Mask in the

Configuration dialog box.
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2. Enter the subnet mask in the neighboring text box, in

hexadecimal. The format of the subnet mask is eight

hexadecimal digits with no periods; for example, enter

ffffff00 for 24 bits for network, 8 bits for host.

Default Host
Telnet allows you to specify the default machine to connect to.

Every subsequent attempt to open a connection will give this host

name as the default entry. To specify a machine, type in the

internet address. If you do not want any machine as the default,

then just leave this field blank.

Capture File
Version 2.5 of Telnet has the feature of being able to save text

from a telnet session into a text file. If the user selects this

feature, all text that is output to the screen will also be dumped

into a file. To name the file that text is dumped to, enter a valid

file name here. When Telnet is used to capture the text from a

session, Telnet will append a unique number to the end of the

specified capture file name. This is done so that text from

multiple sessions can be saved at the same time, without any kind

of ambiguity.

NCSA Telnet Settings File

All of the user-selectable settings for NCSA Telnet (Configure

Network parameters, Preferences selections, and all Aliases) are

stored in the NCSA Telnet Settings file, which is placed in the

System Folder upon creation.

Configuration File

The configuration file (config.tel) contains information

regarding local operating parameters, plus a list of commonly

accessed hosts and optional network tuning parameters for each

of these hosts. config.tel is a text file that can be edited with any

text editor, such as TeachText.

The configuration file is accessed once when the program is

initiated and is not used again. All of the machine names are read

into memory, so it saves memory to limit the number of machine

names you specify in the file.

NOTE:  Editing the config.tel file while the program is running

has no effect on the program's operation. To effect the changes,

you must restart telnet.
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Placing the
Configuration File

For ease of use, place the config.tel file either in your System

Folder or in the folder containing NCSA Telnet. If NCSA Telnet

does not find the configuration file in either of these places, or if

there is an error in the file, the following error message

appears:

cannot find or open configuration file.

This message is described in Appendix A.

The configuration file is a list of keywords and legal values. The

overall requirement for the entries in the file is that they

alternate—keyword, value, keyword, value, and so forth.

Many different formats using any of the allowable delimiters are

possible. The delimiters are the colon (:), semicolon (;), equal

sign (=), and any of the whitespace characters. To include

delimiters in a value field, enclose the field in double quotes.

Quotes cannot be a part of any value field. Wherever a pound sign

(#) is found, everything from # to the end of line is treated as a

comment.

Entry Syntax

Though multiple formats can be used in the same file, you will

probably want to find and keep a consistent format. For example,

the entries in Figure 8.4 specify the same information.
Figure 8.3 Same

Information in

Different Entry

Formats

name=nic    # comment field to end of line ->

host=sri-nic.arpa

hostip=10.0.0.51

scrollback=300

contime=60

- - - - - -Example #1- - - - - - - - -

name=nic; host=sri-nic.arpa; hostip="10.0.0.51";

scrollback=300; contime=60

- - - - - -Example #2- - - - - - - - -

name

nic

host sri-nic.arpa : hostip=10.0.0.51; scrollback=300;

contime:60

- - - - - -Example #3- - - - - - - - -

The first entries in the configuration file are the Macintosh

environment entries. These specify what types of hardware are to

be used and other parameters. In this list, sample values are

included after the equal (=) signs to indicate the correct format.

Entering Macintosh
Information

National Center for Supercomputing Applications



System Administrator Information 8.7

Table 8.3 Macintosh

Information Entries
Entry Specification

arptime=5 †Time in seconds to continue trying to

reach a host on the local wire. A value

of 5 works fine for the network at

NCSA, but larger values may be

needed for hosts that are slow to

respond. Smaller values are more

convenient to use.

domaintime=2 Time in seconds to wait between the

first domain lookup and the second. If

you only have one nameserver, then

this is the same as a simple timeout. If

you want to rotate nameservers

quickly—for example, because the

first one may be down—set this to a

smaller number.

domainretry=4 Number of times to query domain

nameserver(s). Each time a retry is

sent, the timeout value (domaintime)

is doubled. Each time a retry occurs,

NCSA Telnet tries the next

nameserver, wrapping around to the

first nameserver when there are no

more.

domain="ncsa.uiuc.edu" Default root for domain lookups. If a

domain request does not contain a

period (.), then this domain suffix is

appended to the request before it is

sent to the nameserver.

ftp=yes Default FTP serving. Access to your

Macintosh can be controlled by the

FTP password file. To disable FTP

serving by default, change this line to

ftp=no.

NOTE:  This setting can be toggled in

the File menu as well (see

"Transferring Files" in Chapter 5).

passfile="ftppass" The file in which FTP usernames and

passwords can be found. There is no

default name for this file. If the file is

specified, then FTP will prompt for

the username and password for all

FTP attempts. If the file is not

specified, then there is no password

checking for FTP. For more
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information, consult the section of

this chapter entitled "FTP Password

Protection."

Keyword SpecificationTable 8.3 Macintosh

InformationEntries

(Continued)

timeslice=3 Amount of time you are willing to wait

between processing information. This

option is useful only when you are

using MultiFinder, as it lets you run

other programs in the background. The

default is three Macintosh clock ticks.

You should increase this number if the

background operations are more

important or decrease it if Telnet

operations are more important.

hardware=AppleTalk Ethernet device. NCSA Telnet can

support several different kinds of

Ethernet devices. AppleTalk is the

most common configuration, used with

AppleTalk to Ethernet gateways. For

direct Ethernet users, consult the

section of this chapter entitled

"Hardware Options" to determine the

correct setting. Note that this option

is also used to switch between the

NCSA drivers and MacTCP drivers,

and is also used to specify is the user

wants Serial connections.

termtype="dec-vt100" The string to be returned by NCSA

Telnet in response to the telnet

terminal type negotiation command.

The default value for this field is DEC-

VT100. Because many host systems

do not have a record for this terminal

type, you may wish to change it to

VT100.
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zone="KIPzone" †Zone containing the desired gateway.

In some situations, an AppleTalk to

Ethernet gateway may be used even if

that gateway is not in the local

AppleTalk zone. If you specify a

particular zone name here, the query

to find the gateway is directed to that

particular zone. This option only

works when running KIP-compatible

software in the gateway; it is not

compatible with all networking

configurations.

Table 8.3 Macintosh

Information Entries

(Continued)

Keyword Specification

block=120 Size of block of text characters to be

read from the network. CONTROL-C,

the Interrupt Process command, and

all other keypresses are handled only

between blocks. For faster turnaround

on typed commands and CONTROL-C,

set this value to a lower number. For

better overall throughput to the

screen, set this value to a higher

number. The parameter for this

command can range from 100 (good

response time) to 4000 (fast

throughput). Note that setting your

color screen to two-color mode can

improve throughput and scrolling

speed also.

†Ignore these items when using the MacTCP driver version.

After the Macintosh configuration options, you may have zero or

more hosts, with host-specific information for each. Typically,

the first host listed will be name=default, which stores the

default values for the other hosts. Any keyword listed under later

hosts overrides the default setting for that host.

Entering Host-Specific
Parameters
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NOTE:  The keyword name is special because it separates entries.

The parameters following name up to the next keyword name are all

associated with the session name. The parameters are installed

whenever a connection is opened with that session name.

Entry Specification

name=nic The primary name associated with a list of

parameters. It is common to have more than

one session name for a host, each with

different parameters, perhaps with different

colors or amounts of scrollback. A name

keyword is required for each session entry

because it separates entries.

Table 8.4 Host-Specific

Parameters

host=sri-nic.arpa Hostname or alternate name. If you want to

associate both a session name and a hostname

with a particular set of parameters, you may

include both. Note that the name parameter is

required, while the host parameter is optional.

The rule of thumb is: When you have only a

hostname, insert it as name=hostname. If you

have both a session name and a hostname,

enter both name=sessionname and

host=hostname. When you want to open a new

connection, either the hostname or

sessionname works.

Entry SpecificationTable 8.4 Host-Specific

Parameters

(continued)

hostip=10.0.0.51 The IP address of the host. If this is not

present, the domain nameserver must be

queried to get the IP number of the host. For

efficiency, include the IP addresses of all

commonly accessed hosts. IP addresses of

gateways and nameservers are required to be

in the configuration file.

gateway=1 †The gateway precedence for this host. To

reach hosts not connected to your local

network, you must have at least one gateway

entry. The hostip keyword must be present

for this host. Gateway numbers must start at

1 and increase by ones. Gateway 1 has the

highest precedence, but the first gateway to

respond to an ARP will be used. ICMP

redirects can affect how gateways are used,

but not permanently.

nameserver=1 The nameserver precedence for this host.

NCSA Telnet uses UDP to query domain
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nameservers for machine names that are not

in the configuration file. Each machine that is

to be used as a nameserver must have this

keyword listed. The hostip keyword must be

present for this host. Nameserver 1 has the

highest precedence.

Nameserver numbers must start at 1 and

increase by ones.

NOTE:  This is only for the NCSA version.

The TCP version uses the TCP resolver for all

domain-name lookup, making this line

unnecessary.

localkeys=off

localkeys={a,b,c} Local interpretation and default key

assignment of Interrupt, Suspend, nad Resume

(see "Changing the Assigned Keys for

Interrupt, Suspend, and Resume" in Chapter

2).  localkeys=off inhibits local interpretation

of these commands, passing all keys directly

to the host.  localskeys="{a,b,c}" assigns the

commands to specified keys, where 1 is

CONTROL-A, 26 is CONTROL-Z, and the

defaults are 3(CONTROL-C) for Interrupt, 19

(CONTROL-S) for Suspend, and 17 (CONTROL-

Q) for Resume.

scrollback=100 The number of lines of scrollback for this

session. Be aware that scrollback occupies at

least 86 bytes per line saved. There can be a

different number of lines of scrollback for

each session. Plan your use of scrollback

wisely unless you have memory to spare.

erase=delete The backspace translation for this host. Some

hosts prefer the BACKSPACE key to send

delete and some prefer the BACKSPACE key to

send backspace. Set this value erase=delete or

erase=backspace.

Entry SpecificationTable 8.4 Host-Specific

Parameters

(continued)

crmap=4.3bsdcrnul End of line character. This example is a

special compatibility option for 4.3 BSD UNIX.

There is now an official UNIX bug fix to take

care of the problem, but some hosts may still

want crnul to be used for end-of-line. The

default is crmap=CRLF, which sends CRLF

when you press RETURN. In line mode, CRLF is

always used.
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duplex=half Echo mode setting. This parameter only

applies to hosts that negotiate non-echoing

mode but do not expect local line editing. If set

to half, all character keys are sent and echoed

to the screen immediately, otherwise the

characters are echoed locally and queued until

a RETURN or CONTROL character is sent. This

parameter has

no effect in echo mode; that is, when local

echo is off.

contime=10 †The connection timeout in seconds. When you

are making a connection attempt, NCSA Telnet

gives up on opening the connection and deletes

the window after this amount of time has

elapsed. For congested or slow networks, this

value should be made larger.

retrans=25 †The initial retransmission timeout in 60ths of

a second. Increasing the value of this

parameter may help in reducing the initial

burst of retries that is typical of connections

with high round-trip times.

mtu=512 †The largest amount of data to put in the

packets that are sent. If you are sending to the

ARPANET, you should use mtu=512. If you are

sending to local hosts and are using EtherTalk,

you should use mtu=1024.

NOTE:  Do not set mtu to be greater than 512

if you are using an AppleTalk gateway.

tektype=4105 Type 4105, or 4014 depending on which

emulation typs is desired. You can also specify

"none", in which case TEK displays are not

allowed.  If the tektype keyword is not

present, Telnet will always prompt the user

for a TEK type each time a TEK operation is

performed.

forcesave=n A value of "y" forces Telnet to always save

the contents of the screen to the scrollback

buffer. This option is ONLY for users of full

screen VMS environments such as DEC All-In-

One, in which case the value should be "y".

The value of  "n" is default, and recommended.

Entry SpecificationTable 8.4 Host-Specific

Parameters

(continued)

eightbit=0 Type 0 to disallow processing of 8-bit fonts.

In that case, the 8-th bit of incoming data will

be stripped, as in previous versions of NCSA
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Telnet. Type 1 to allow 8-bit characters to be

passed.

linemode=N Type N to disable line-mode negotiations. Type

Y to enable Telnet to enter line-mode. This

option is obviously meaningful only on hosts

that support the line-mode protocol.

maxseg=512 †The largest segment that can be received.

This value can control the size of packets that

are sent over the connection. Reducing this

value can eliminate IP fragmentation that we

cannot reassemble. A value of maxseg=512

should force the sending host to never

fragment. As with the mtu setting, do not set

it larger than 512 if you are using an

AppleTalk to Ethernet gateway.

rwin=512 †Receive window size. Unfortunately, some of

the popular Ethernet hardware cannot handle

receiving back-to-back packets. This requires

us to limit the TCP receive window that we

advertise to other hosts. For communicating

to slower hosts or when using high

performance hardware, a larger window

(4096 is the maximum) may work better.

port=23 The TCP port number to use when connecting

for this session. The default telnet port is 23,

the Internet standard port number for the

telnet protocol. Some networks—for example,

MFENET

(port=911)—use other port numbers, so this

option should be specified for hosts on those

networks.

nfcolor={0,0,0} Normal, foreground color

nbcolor={0,0,0} Normal, background color

bfcolor={0,0,0} Blink, foreground color

bbcolor={0,0,0} Blink, background color

These options can be used to specify default

colors for Macintosh computers which can

handle color sessions. The format of the color

specifier is {red, green, blue}, where red,

green, and blue are the integer numbers

corresponding to the requested colors (as

shown in the standard Macintosh Color Wheel

dialog box, shown in Figure 3.7). These options

have no effect on non-color Macintosh

computers, and their presence is harmless.
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Table 8.4 Host-Specific

Parameters

(continued)

Entry Specification

vtwrap=yes Wrap mode setting. The VT102 terminal

maintains an internal setting to determine

whether characters printed off of the right

hand side of the screen causes the terminal to

wrap or not. If the terminal is set to wrap,

the new characters appear on the next line of

the screen (scrolling if necessary). If wrap

mode is off, each new character replaces the

last character on the current line and the

cursor does not move. Set this option to yes

or no to indicate the initial setting for this

session.

NOTE: Host software commonly sets the

wrap mode, overriding this setting. You may

also override this setting in the Session menu

(see "Using the Session Menu" in Chapter 3).

vtwidth=132 Screen width. When a session is opened,

memory is allocated for a screen width of 80

or 132 characters, depending upon the setting

of vtwidth. These correspond to the two legal

screen widths for a VT102 terminal.

clearsave=yes Whether or not to save the screen when a

clear screen command is received. Scrollback

is now updated when the screen is cleared.

When clearing the screen, all of the visible

lines are saved into the

scrollback region. If you prefer not to have

the text saved when the screen clears,

specify clearsave=no. In the case of host

programs which clear the screen one line at a

time, the lines are never saved into the

scrollback region.

font="Monaco" Default font for each session. The font name is

a text string and must exactly match the name

of the desired font in your System File.

fsize=9 Default font size (in points) for each session.

vtlines=24 Number of lines of text to appear in the VT102

emulation window. When the connection opens,

NCSA Telnet creates the appropriate size

window for the the font type and size and the

number of lines to display.
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NOTE:  The VT102 terminal has exactly 24

lines.  If you create a window larger or

smaller, your host system may not be able to

correctly update the screen.  If you have

problems, reset your screen to 24 lines with

the Set Usable Lines command in the Session.

Entry SpecificationTable 8.4 Host-Specific

Parameters

(continued)

copyfrom=nic Setting of unspecified parameters. The

copyfrom parameter is probably the most

important—it causes all unspecified

parameters to be copied from a previous

entry. Note that the entry to copy from must

appear above the entry to copy to. For

machines of a similar type, only one entry has

to be customized and the rest include

copyfrom commands. For a given host,

parameters that are specified along with a

copyfrom command override the copyfrom

directive.

Included with the distribution of NCSA Telnet is an awk script

called newh. The script is also listed in Appendix C. Used with the

following command under 4.XBSD UNIX, the scripts converts the

/etc/hosts file into a format compatible with NCSA Telnet's

configuration file. Note that domain name lookup should make this

operation obsolete, or make it apply to only a small subset of

your /etc/hosts file. At the prompt enter:

Converting UNIX /etc/
hosts Files

awk -f newh /etc/hosts >config.temp

After creating this new file, prepend the Macintosh-specific

information and download it to the Macintosh.

Hardware Options (NCSA Drivers)

This section discusses the various hardware options available if

you are using NCSA Telnet with the NCSA drivers.

All of the network drivers are combined into one application. You

must use the hardware entry in the configuration file to inform

NCSA Telnet which method of Ethernet connection you are using.

Choose from the list in Table 8.6.

Combined Network
Drivers
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NOTE:  If you have MacTCP, the network is configured for the

MacTCP drivers. To specify this, you need to specify

hardware=MacTCP in the configuration file. You may also leave

out the hardware=  line entirely, since MacTCP is the default.

Value Ethernet Connection
Ether Attempt to figure out which device and (if

applicable) slot

Ether9 EtherTalk board or other EtherTalk compatible

Ethernet board in slot 9

Ethern EtherTalk board or other EtherTalk compatible

Ethernet board in slot n

Table  8.5 Ethernet

Values for

Hardware Options

Supported by

NCSA Telnet

EtherSC SCSI Ethernet device

EtherSE Mac SE internal Ethernet board

AppleTalk AppleTalk network (default value)

MacTCP Use MacTCP drivers

Serial Use serial drivers

NCSA Telnet works best over an Ethernet interface. The term

EtherTalk has two referents: AppleTalk protocols on Ethernet and

a device independent way of using Ethernet for applications.

AppleTalk protocols on Ethernet allow fast access to Appleshare

servers, and so forth. NCSA Telnet does not require these

protocols, so the setting of built-in AppleTalk versus EtherTalk

in the Control Panel does not affect NCSA Telnet. NCSA Telnet does

require you to install EtherTalk to use an Ethernet device, but

you do not have to enable AppleTalk for that device.

AppleTalk and
EtherTalk

If you do not have an Ethernet device, you must have an Ethernet

to AppleTalk gateway in order to run NCSA Telnet (see the

hardware list in Table 8.1). In such situations, NCSA Telnet

communicates with the gateway using TCP/IP encapsulated in

AppleTalk packets.

You must correctly set the values of maxseg, mtu, and rwin in

the configuration file to get maximum data transfer throughput

between machines. Here are some rules of thumb to use when

setting these values.

Performance Tuning

• The maximum reasonable values for these parameters are:

rwin=4096

mtu=1024

maxseg=1024

• The setting required for users running NCSA Telnet over

AppleTalk protocols, and any other troublesome network

situation, also the most conservative setting, is:

rwin=512
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mtu=512

maxseg=512

• The best setting for local network use with an Ethernet board

is:

rwin=4096

mtu=1024

maxseg=1024

• The best setting for ARPANET use (or any situation with a lot

of unknown gateways, but with an Ethernet board) is:

rwin=4096

mtu=512

maxseg=512

rwin specifies how much data the other computer is allowed to

send you at any one time, so it depends mostly upon your local

Ethernet board. If the board can handle it, always specify

rwin=4096.

maxseg is used to avoid fragmentation. If you ever get fragmented

packets, lower the value of maxseg for that host until

fragmentation stops occurring.

Domain Name Lookup (NCSA Drivers)

When NCSA Telnet cannot find a name in the configuration file, it

may still find the IP number if you are running a domain

nameserver. At least one nameserver entry is required in the

configuration file, but there may be more. If one nameserver

fails to respond, the one with the next higher precedence is

queried. As soon as a response is received, NCSA Telnet attempts

to open a telnet connection.

When you enter a name to open a connection, there is a specific

domain search order:

Domain Search Order

1. The name is looked up as a session name from the

configuration file.

2. The name is looked up as a hostname from the

configuration file.

3. The name is sent as a domain query to the first

nameserver.

4. The query is repeated if the domain request times out, but

to another nameserver. This is repeated until the maximum

number of retries is reached or a response is received.
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With the domain nameserver, the number of hosts in the

configuration file can be kept to a minimum. Each host in the

configuration file will be a commonly used computer. The IP

addresses for rarely used hosts will be accessible if the domain

name retrieval system can resolve those hosts.

NCSA Telnet can append a default root domain if desired. To enable

this feature, use the domain=keyword (as discussed in the section

entitled "Configuration File") to specify the root domain that you

want appended. If a hostname which is not in the Configuration

File is requested and that name does not contain a period (.), the

domain request is made with the default domain appended to that

name.

Default Domain

Domain Name Lookup (MacTCP Drivers)

If MacTCP drivers are specified to handle domain name resolving,

then the MacTCP domain name resolver handles all name lookup.

By doing so, NCSA Telnet conforms to the TCP standard, as well as

simplifies many internal processes. This feature also allows you

to use NCSA Telnet with other TCP products simultaneously and

without conflicts. It also leaves all name-serving specific code

where it belongs -- outside of the application.

FTP Password Protection

The presence of the passfile keyword in the configuration file

enables FTP password protection. If you include the password file

keyword, FTP will not allow any FTP connections to open without

a correct username and password. In order to use the FTP server

to access any folder on your local disk, you should include the

password file name as a full path name. For example,

passfile="hd40:NCSA Telnet:mypassfile"

You can have several usernames and individual passwords for

each user. The passwords are encrypted, but not with a secure

encryption system. Only trusted users should have access to the

password file. Use the program Telpass (included with the NCSA

Telnet distribution) to encode passwords (see "Using Telpass" in

Chapter 5 for more information).

Compatibility

NCSA Telnet responds to ping (ICMP echo) requests. This request

may be used by other hosts to determine whether your Macintosh

is online.

Ping
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VT102 The VT102 emulator is nearly complete. VT102 features not

emulated are double width and double height characters, and

VT52 mode.

Some gateway configurations, do not support ICMP redirects.

ICMP redirects currently work only with the EtherTalk-based

configurations.

ICMP Redirects

Trailers were invented for an old version of Berkeley UNIX and

have been haunting us ever since. NCSA Telnet does not support

trailers. Your host machine must have trailers turned off for

NCSA Telnet to work with your host. Some versions of ULTRIX

from Digital Equipment Corporation have been shipped with

trailers left on by default. If NCSA Telnet hangs up when you type

out large text files, check the trailers setting for that host's

ifconfig.

Trailers

The FTP server in NCSA Telnet is close to the DARPA

specification for the minimum implementation. Exceptions are:

FTP

• The command connection does not perform telnet negotiation.

• Block mode of FTP is not supported.

• Some error conditions may display as command not understood

instead of returning more appropriate messages.

The standard Telnet protocol has several potential options that

can be invoked if both parties of the telnet connection agree. NCSA

Telnet refuses most of these options, but accepts echo (option 1);

suppress go ahead (option 3); and terminal type (option 23).

There are some obscure features of the telnet specification that

are not supported in this implementation: out-of-band

interrupts are not available, go ahead signals do nothing, and

telnet acknowledge signals are not acknowledged. If there are any

problems with the limitations of NCSA Telnet, please submit a

bug report using the form provided at the end of this manual.

Telnet
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Serial Commnuications 9.1

Chapter Overview

This chapter is meant to be a brief introduction to serial

communications, and how they are implemented in NCSA Telnet

version 2.5. The format of this chapter will first include a

general introduction to serial communication, and then focus on

how to use this with Telnet. Also included is an overview of SLIP.

What is Serial Communication?

Normally NCSA Telnet connects to host machines through the

ethernet cable. All the data is transmitted through this ethernet

line in a very fast, efficient way. However, that normally

necessitates needing a direct ethernet connection in order to

communicate with host machines via Telnet.

Fortunately there is another way to communicate with host

machines, and that is through the phone line. By using a modem,

it is possible to transfer data from your computer over the

phone. This is exactly what serial communication is. For people

who do not have the option of using ethernet, it is easy and

practical to use the phone line to connect to a remote host, and

this new version of Telnet has this feature.

Setting Everything Up

To use the serial communication feature, you will need to do

several things. A modem is going to be a necessary piece of

equipment, since it is the device that is able to encode and decode

the serial data from the phone line. Obviously you are going to

want the data connection to be as fast as possible, so it is

naturally advantageous to have a fast modem. Another modem

feature that is going to be handy is the ability for the modem to

auto dial -- that will make the job of connecting a lot easier.

The modem is going to have to be connected to a phone line, so that

there is a path for data transfer going to the rest of the world.

Similarly, the modem is also going to be connected through a

serial port on the computer. This can be either the modem port,

or the printer port

Now that your hardware is set up properly, you must configure

Telnet to recognize how data is going to be transferred. This is

done by configing the Serial Port Setting. To do this, choose the

item Serial Port Settings from the Network Menu, shown in

Figure 9.1 for reference. For more information about how to

configure the Serial Port, please see Chapter 4, in the section

"Serial Port Settings."

June 1992



9.2 NCSA Telnet

Figure 9.1 Network

Menu

Connecting

Now that everything is properly set up, you can proceed to make

a connection over the phone line. Try opening a session, which

brings up the Open Connection Dialog Box, shown again below in

Figure 9.2.

Figure 9.2 Open

Connection Dialog

Box

This time select Serial/SLIP by either clicking in the

appropriate box, or by hitting Command-S.  This will tell Telnet

to use this connection through the serial port. When you do this,

a blank window should open up, awaiting further commands. At

this point, you will need to properly use your modem to connect.

NOTE:  Not all modems are compatible, and therefore there is not

one de-facto standard for connecting. You are probably going to

want to read your Owners Manual to become familiar with its

operations.

National Center for Supercomputing Applications



Serial Commnuications 9.3

At this point, there is an open line for data transfer, but no

actual connection. To connect, you need to have the modem dial the

number of a Terminal Server. A Terminal Server is a machine

that allows a modem to connect to it. Through this server you are

allowed to remotely log in to hosts around you.

Connection Example Perhaps the easiest way to illustrate the process of opening a

serial connection is to give a concrete example. This example is

exactly how to open a connection at NCSA, and perhaps this will

give you an idea of how things work elsewhere.

1. Start opening a connection by bringing up the Open

Connection Dialog Box, and select Serial/SLIP connection as in

Figure 9.2 above.

2. A blank window opens up. From here it is time to dial the

number. Using a Hayes SmartModem 1200, you can give a

direct command to auto-dial. For that particular modem, you

can type:

ATDT 244-0662

ATDT tells the modem to dial the following number, and 244-

0662 is the phone number of a Terminal Server here.

The modem should respond with dial tones, and then some

connection sounds.

3. At this point, the screen should respond with an opening

message to tell you that you are connected. This display should

look somewhat similar to Figure 9.3, "Serial Session

Window." You are still not connected to your host however, so

from here you will still need to log in.

4. Remotely log into your host. Once again, this could

perhaps vary somewhat depending on your site, and what

protocols are available. At NCSA, it is possible to log in with:

rlogin yoyodyne.ncsa.uiuc.edu

5. If you have specified a proper machine to telnet to, then

you should be asked for a login and password. From there, the

connection will proceed exactly as if you were just using a

standard ethernet connection.
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Figure 8.3 Serial

Session Window

SLIP Overview

Besides the ability to make a serial connection over a phone line,

this version of Telnet also has the feature of being able to make a

SLIP connection over a phone line. SLIP is a protocol that allows

a modem to act as an actual ethernet connection, and therefore

circumvent the need to dial a Terminal Server and remotely log

in elsewhere. Instead, SLIP allows the user to just specify

directly the IP address of the host machine, and connection

proceeds as it would for a normal ethernet session.

Unfortunately, using SLIP requires quite a bit of initial

configuration. First, you need a way to identify your macintosh to

the rest of the network. This is done by setting up the SLIP IP#

of your macintosh. To do this, once again select Serial Port

Settings from the Network Menu, shown in Figure 9.1. When the

Serial Port Settings dialog box comes up, you will need to specify

the IP number that SLIP will use for your macintosh. For more

information about setting this value, please see Chapter 4, in the

section "Serial Port Settings," and Appendix D, "Getting SLIP to

Work."

Setting Things Up for
SLIP

NOTE:  Telnet 2.5 does not currently support BOOTP, which

allows dynamic IP number assignment with SLIP. It is for that

reason that you must statically assign a SLIP IP# for your

macintosh.

There are a few other items that need to be properly configured

on the host end, for SLIP to work. To do this, please refer to

Appendix D, "Getting SLIP to Work." You will probably need to

get your System Administrator to set everything up properly on

the host end.
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Making a SLIP
Connection

Once SLIP is properly configured, it is very easy to open a SLIP

connection from Telnet.

1. Open up the Connection Dialog box just as you always

would for making a connection.

2. Select the Serial/SLIP option by clicking on the

appropriate box. This will open a blank session window, just

as if you were going to attempt to open a normal serial

connection.

3. At this point, you may go into the Session Menu, as shown

in Figure 9.4, and select the Switch to SLIP menu item.

Figure 8.3 Session

Menu

The session menu will then disappear, and the Open Connection

Dialog Box will once again appear. This time, however, you are

going to be connecting through the serial line. You may type in a

valid IP address, and the connection will continue just as if you

were connecting directly over ethernet. However, you are not

connecting over ethernet, but rather the phone line.
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Appendix A Error Conditions

Overview
Most of the error conditions in NCSA Telnet are nonfatal. The most

important and common error messages are listed here with a

short summary of the symptoms and causes.

Common Errors
The following messages may appear on your screen during the

operation of NCSA Telnet. Any other messages that appear are

protocol-specific messages that may require additional diagnosis

from the system administrator. If a message that is not

documented here occurs repeatedly, please contact your system

administrator first. If you cannot find a solution, please submit a

bug report using the form provided at the end of this manual.

AppleTalk initialization failed; couldn't install listener

or

EtherTalk initialization failed; couldn't install listener

Cause:

NCSA Telnet is having difficulty conversing with AppleTalk or

EtherTalk, respectively. There are a number of possible causes

for this, such as the use of conflicting and improperly coded

AppleTalk or EtherTalk programs.

Solution:

If you are concurrently using another AppleTalk product, try

running NCSA Telnet without it. Otherwise:

1. Reboot.

2. Check that AppleTalk is connected in the Control Panel or

Chooser desk accessory, if you are using AppleTalk.

Check whether your configuration file contains the

specification hardware=ether (see Chapter 8).

3. Try running NCSA Telnet again.
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Cannot find or open configuration file

Cause:

NCSA Telnet normally operates with a configuration file. This file

could not be found.

Solution:

A dialog box, shown in Figure A.1, appears on your screen. Click

on this error dialog box to continue. A dialog box appears from

which you may elect to quit the program and return to the Finder,

or find a suitable configuration file elsewhere on your disk.

Figure A.1 Missing

Configuration File

Dialog Box

If you choose to find a different file, NCSA Telnet displays a

standard directory dialog box from which you can select the text

file to use as your configuration file. This does not permanently

change the name or place that NCSA Telnet looks for its

configuration file. To prevent the error dialog box from being

displayed again, put your configuration file into the folder

containing NCSA Telnet or the System Folder.

ICMP: Destination unreachable

Cause:

Another machine—probably the gateway—has determined that

your message cannot reach its destination from your system.

Solution:

Check the IP address in your configuration file. Notify your

system administrator that the gateway cannot connect you to the

destination you want to reach. There may be a problem with the

gateway.

Local Host or gateway not responding

Cause:

Possible reasons this error occurs are: network problems, a

configuration file problem, the computer you want to connect to

is down, or the gateway that you need is down.
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Solution:

If the computer is on your local network, check to see that the

network is up and running. If the computer is not on your local

network, check to see if the gateway is up and running. Ask the

system administrator to check the specification of the gateway in

your configuration file. Check the IP number of the computer to

which you are trying to connect. Check to make sure that your

computer is attached to the network. Check the integrity of the

network cable. Check any Ethernet devices' configuration of thick

versus thin Ethernet.

not enough memory left to open

Cause:

Your system ran out of memory. This is the most common barrier

to opening more sessions.

Solution:

Log off of some of your sessions or provide more memory in

which NCSA Telnet can run. Providing more memory may mean

buying more or allocating more memory under MultiFinder.

No internal TCP ports available

Cause:

You are trying to do too many activities at the same time, or some

combination of your activities has not closed the TCP sessions

correctly. This will happen if you open too many sessions to other

computers.

Solution:

Close some of your existing sessions. If necessary, exit the

program by logging off all of the other computers and restart

NCSA Telnet.

unable to open resolver

Cause:

You are trying to run the MacTCP version of NCSATelnet when you

don't have MacTCP installed.  This message signals that NCSA

Telnet couldn't open the MacTCP domain name resolver.

Solution:

If you do not have MacTCP installed, you should either install

MacTCP, or change the hardware line in config.tel to either

Appletalk, ether, or some other appropriate option.

If you have MacTCP installed, try the following:

1. Delete the 'MacTCP Prep', and 'MacTCP DNR' files from

the System Folder, and restart your Mac.
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2. Make sure the IP number in MacTCP is correct (if

obtaining manually).

3. Make sure you have the correct option under Obtain

Address in MacTCP.

4. Verify that you have the correct class network option

chosen in MacTCP.

Error opening TCP drivers

Cause:

A configuration problem.

Solution:

If you are using MacTCP, check the following in your MacTCP

control panel:

1. Verify the Obtain Address option is set correctly.

2. Make sure your IP number is properly set.

3. Make sure that the subnet mask is correct for your

network.

Possibly no dynamic addressing

Cause:

Your network options in MacTCP are not configured correctly.

Solutions:

If you are using MacTCP, check the following options in your

MacTCP control panel:

1. Make sure that your Obtain Address option is set

correctly. Telnet is possibly reporting an error with the way

your IP number is assigned.

2. Verify that the IP number is correct, if obtaining the IP

address manually.

3. Check that the subnet mask is correct for your network.

host not on file or on server

or

host or gateway not responding

Cause:

Telnet is unable to resolve the host's address that you are trying

to connect to.
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Solutions:

If you are using MacTCP, check the following options in your

MacTCP control panel:

1. Make sure that the domain Name Server Info Box is filled

out properly, and the default name server is specified.

2. Delete the 'MacTCP Prep' and 'MacTCP DNR' files from

your System Folder, and restart the Macintosh.

3. Verify the correct Ethernet/Ethertalk option is chosen.

4. Make sure that the gateway is properly specified.

5. Make sure that the correct Obtain Address option is

selected.

6. Verify that the subnet mask is correct for your network.
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Overview
This appendix explains how to convert UNIX /etc/hosts files to

the new configuration file format.

Converting Files
Below is the contents of the awk script newh, which converts

UNIX /etc/hosts files. To convert the files, use:

awk -f newh /etc/hosts > newfile

 {

 if (substr($0,1,1) != "#") {

if (substr($2,1,1) == "@") {

print "name=" $3 " ; hostip=" $1

j = 4

}

else {

print "name=" $2 " ; hostip=" $1

j = 3

}

 for (i=j; i<=NF; i++) {

 print "name=" $i " ; copyfrom=" $(j-1)

}

}

}

June 1992



Appendix  C Obtaining NCSA Software

Overview
This appendix uses NCSA Telnet to outline the procedures for

obtaining NCSA software via FTP, an archive server, or by

regular mail.

Obtaining NCSA Software

If you are connected to Internet (NSFNET, ARPANET, MILNET,

etc.) you can download Telnet software and documentation, along

with other software, at no charge from an anonymous file

transfer protocol (FTP) server at NCSA. The steps you should

follow to do so are enumerated below. If you have any questions

regarding the connection or procedure, consult your local system

administrator or network expert.

FTP

1. Log on to a host at your site that is connected to Internet

and is running software supporting the FTP command.

2. Invoke FTP on most systems by entering the Internet

address of the server:

%  ftp  ftp.ncsa.uiuc.edu

or

%  ftp  141.142.20.50

3. Log in by entering anonymous for the name.

4. Enter your name for the password.

5. Enter get README.FIRST to transfer the instructions

file (ASCII) to your local host.

6. Enter quit to exit FTP and return to your local host.

7. Review the README.FIRST file for complete instructions

concerning the organization of the FTP directories and the

procedures you should follow to download the README files

specific to the application you want.
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Your login session should resemble the following sample, where

the remote user's name is smith and user entries are indicated in

boldface type.

harriet_51%  ftp ftp.ncsa.uiuc.edu
Connected to zaphod.

220 zaphod FTP server (Version 4.173 Tue Jan 31 08:29:00 CST

1989) ready.

Name (ftp.ncsa.uiuc.edu: smith):  anonymous
331 Guest login ok, send ident as password.

Password:  smith
230 Guest login ok, access restrictions apply.

ftp>  get README.FIRST
200 PORT command successful.

150 Opening ASCII mode data connection for README.FIRST (10283

bytes).

226 Transfer complete.

local:  README.FIRST  remote:  README.FIRST

11066 bytes received in .34 seconds (32 Kbytes/s)

ftp>  quit
221 Goodbye.

harriet_52%

The README.FIRST file instructs you to copy the Telnet README

file to your directory and read it before proceeding. Your FTP

session should resemble the one listed below:

ftp> cd Mac/Telnet
250 CWD command successful.

ftp> get README
200 PORT command successful.

150 Opening ASCII mode data connection for README (10283 bytes)

226 Transfer complete.

local:  README remote:  README

2080 bytes received in .14 seconds (15 Kbytes/s)

ftp> quit
221 Goodbye.

harriet_52%

The Telnet README file explains how to copy the contents of the

Telnet directory to your home directory via remote login or

anonymous FTP. The precise file transfer procedure varies

according to the type of operating system you use.

To obtain NCSA software via an archive server:Archive Server

1. E-mail a request to:

archive-server@ncsa.uiuc.edu

2. Include in the subject or message line, the word "help."

3. Press RETURN.

4. Send another e-mail request to:
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archive-server@ncsa.uiuc.edu

5. Include in the subject or message line, the word "index."

6. Press RETURN.

For example, if you use the UNIX mailing system, your login

session should resemble the following sample, where user

entries are indicated in boldface type.

yoyodyne_51% mail archive-server@ncsa.uiuc.edu
Subject:  help

.

EOT

Null message body; hope that's ok

yoyodyne_52% mail archive-server@ncsa.uiuc.edu
Subject:  index
.

EOT

Null message body; hope that's ok

The information you receive from both the help and index

commands will give you further instructions on obtaining NCSA

software. This controlled-access server will e-mail the

distribution to you one segment at a time.

NCSA Telnet software and manuals are available for purchase—

either individually or as part of the anonymous FTP reel or

cartridge tapes—through the NCSA Technical Resources Catalog.

Orders can only be processed if accompanied by a check in U.S.

dollars made out to the University of Illinois. To obtain a catalog,

contact:

Mail

NCSA Documentation Orders

152 Computing Applications Building

605 East Springfield Avenue

Champaign, IL  61820

(217) 244-0072
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Appendix  D Getting SLIP to Work

Overview
This appendix describes the actions necessary to get SLIP up and

running with NCSA Telnet. It is the step by step procedure that

was used to set up SLIP on an ULTRIX workstation.  This is

intended to be done ONLY by the system administrator, since it

involves some changes in the system's configuration.

Setting Up SLIP
You can establish connections from NCSA Telnet to a DecStation

5000 after configuring the DecStation for SLIP. To do this, the

following procedures must be followed.

NOTE:  This procedure involves changing some configuration

parameters on the host machine's system, and is therefore only

intended to be followed by the system administrator.

1. You must reconfigure the Ultrix kernel to include the

SLIP driver.

2. Create an entry in "/etc/hosts" for the host slip1 to give

it an IP number -- this provides static IP assignment since

Telnet does not currently handle bootp dynamic addressing. Add

a line similar to the following:

128.187.2.221 slip1

3. Make two entries in "/etc/sliphosts" for "slip1" which is

used by "slattach" and specifies some ifconfig parameters for

the slip connection. These lines can be as follows:

jim jim.cs.byu.edu 128.187.9.50 255.255.0.0. any
/dev/tty

slip slip1.cs.byu.edu dbms 255.255.0.0 any /dev/tty

4. Create an account called "slip1", but do not specify the

standard "/bin/csh" login shell. Instead, you need to specify

the SLIP interface"/usr/new/slattach." You will need to have a

password entry similar to the following:

slip1:password:105:10:Logan:/usr/staff/loganj:/usr/
new/slattach
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5. Finally, you need to create the proper network routing

for the "slip1" host, so that network traffic intended for

"slip1" would be directed to the ethernet address of the

DecStation 5000. This can probably done on your system in

your "etc/rc.local" file with the "arp" command.

/usr/etc/arp -s 128.187.2.221 8:0:2b:1d:2a:f8 pub

That is all for the Ultrix setup. At this point it is possible to

establish a serial connection using NCSA Telnet to the Ultrix

host, and login as slip1.

For more information on how to open SLIP and serial

connections, please see Chapter 9, "Serial Communications."
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Overview
This appendix describes briefly the escape codes that are sent by

Telnet with vt200 emulation.

The Codes

Telnet 2.5 has the new feature of being able to emulate a VT200

terminal. This, therefore, is intended to be a bried listing of

escape codes that Telnet sends when acting as a VT200 keyboard.

NOTE:  This is not in any way intended to be the de-facto

reference for vt200 emulation. If a full, descriptive reference

for vt200 emulation is needed, you might want to get an actual

manual for this emulation.

The remainder of this appendix just describes the keyboard

mapping that Telnet uses.

F1 to F4 are the top four keys on the Mac keypad(clear = / *).

F6 to F20 are mapped to F1 to F15 on the Mac extended keyboard.

F5 is not mapped because it performs VT200 local function only.

The escape sequences (in decimal) generated by the Mac keyboard

are as follows:
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Table E.1 Macintosh  escape codes used for VT200 emulation

Non Keypad Mode Keypad Mode
Mac Key VT200Key Esacpe Sequence Escape  Sequences

clear PF1 27 79 80 same

= PF2 27 79 81 same

/ PF3 27 79 82 same

* PF4 27 79 83 same

help Find 27 91 49 126 same

home Insert Here 27 91 50126 same

page up Remove 27 91 51 126 same

del Select 27 91 52 126 same

end Prev Screen 27 91 53 126 same

page down Next Screen 27 91 54 126 same

F1 F6 27  91  49  55  126 same

F2 F7 27  91  49  56  126 same

F3 F8 27  91  49  57  126 same

F4 F9 27  91  49  48  126 same

F5 F10 (help) 27  91  49  49  126 same

F6 F11 (do) 27  91  49  51  126 same

F7 F12 27  91  49  52  126 same

F8 F13 27  91  49  53  126 same

F9 F14 27  91  49  54  126 same

F10 F15 27  91  49  56  126 same

F11 F16 27  91  49  57  126 same

F12 F17 27  91  49  49  126 same

F13 F18 27  91  49  50  126 same

F14 F19 27  91  49  51  126 same

F15 F20 27  91  49  52  126 same

arrow up 27 91 65 27 79 65

arrow down 27 91 66 27 79 66

arrow right 27 91 67 27 79 67

arrow left 27 91 68 27 79 68
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Bugs and Suggestions

Please notify us of any bugs you have found in our software and any

suggestions you have for future releases or products.

Using the report form below, mail user feedback, bugs, or software

suggestions via U.S. mail to:

NCSA Software Tools Group

152 Computing Applications Bldg.

605 East Springfield Avenue

Champaign, IL 61820

Send reports regarding bugs, software suggestions or comments via

electronic mail to:

mactelnet@ncsa.uiuc.edu

mactelnet@ncsavmsa.bitnet

Name:                                                                                                          

Institution:                                                                                                 

Address (Electronic):                                                                                   

Address (U.S. Mail):                                                                                     

                                                                                                                                                    

                                                                                                                                                    

Telephone:   (          )                   –                           .

Version of NCSA Telnet:                              Type machine:                            

Version of system software:                                                                        

Suggestion or description of problem:

                                                                                                                                                    

                                                                                                                                                    

                                                                                                                                                    

                                                                                                                                                    

mailto:mactelnet@ncsa.uiuc.edu
mailto:mactelnet@ncsavmsa.bitnet


                                                                                                                                                    



Place

Stamp

Here

NCSA Software Tools Group

Telnet

152 Computing Applications Building

605 East Springfield Avenue

Champaign, IL 61820


